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1 Foreword
The DriveControlSuite commissioning software for 6th generation drive controllers offers convenient functions for efficient
project configuration and commissioning of drive controllers in multi-axis and single-axis applications.

The PROFIdrive application included in the software contains various application classes for controller and drive-based
motion profiles. Jog mode is available in all application classes for commissioning, emergency operation,and maintenance
or repair work.

This documentation describes the general functions of the PROFIdrive application and guides you step by step through the
setup and project configuration of your drive project in the individual application classes.
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2 User information
This documentation supports you during the setup and project configuration of your drive system with the PROFIdrive
application, which is based on the internationally standardized PROFIdrive drive profile for electric drives in accordance
with IEC 61800-7-303 (version 4.2).

Commissioning is described using examples of a PROFINET network with STOBER 6th generation drive controllers in
combination with a Siemens AG controller.

Technical knowledge

To be able to commission one or more drive controllers in combination with a controller using the PROFIdrive application,
you should have basic knowledge of handling 6th generation STOBER drive controllers and of the DriveControlSuite
commissioning software. Operating your PROFINET network requires being familiar with PROFINET network technology and
the basics of the associated Siemens SIMATIC automation systems.

Technical requirements

Before you begin operating your PROFINET network, you need to wire the drive controllers and initially check that they are
functioning correctly. To do this, follow the instructions in the manual for the relevant drive controller.

2.1 Storage and transfer
As this documentation contains important information for handling the product safely and efficiently, it must be stored in
the immediate vicinity of the product until product disposal and be accessible to qualified personnel at all times.

Also pass on this documentation if the product is transferred or sold to a third party.

2.2 Described product
This documentation is mandatory for SC6 and SI6 series drive controllers in conjunction with the DriveControlSuite software
(DS6) in V 6.7-A or later and associated firmware in V 6.7-A-PN or later.

2.3 Directives and standards
Refer to the drive controller documentation for the European directives and standards relevant to the drive controller and
accessories.

2.4 Timeliness
Check whether this document is the latest version of the documentation. We make the latest document versions for our
products available for download on our website:
http://www.stoeber.de/en/downloads/.

2.5 Original language
The original language of this documentation is German; all other language versions are derived from the original language.

http://www.stoeber.de/en/downloads/
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2.6 Limitation of liability
This documentation was created taking into account the applicable standards and regulations as well as the current state of
technology.

No warranty or liability claims for damage shall result from failure to comply with the documentation or from use that
deviates from the intended use of the product. This is especially true for damage caused by individual technical
modifications to the product or the project configuration and operation of the product by unqualified personnel.

2.7 Formatting conventions
Orientation guides in the form of signal words, symbols and special text markups are used to emphasize specific
information so that you are able identify it in this documentation quickly.

2.7.1 Display of warning messages and information
Warning messages are identified with symbols. They indicate special risks when handling the product and are accompanied
by relevant signal words that express the extent of the risk. Furthermore, useful tips and recommendations for efficient,
error-free operation are specially highlighted.

ATTENTION!

Attention

This indicates that damage to property may occur

▪ if the stated precautionary measures are not taken.

CAUTION!

Caution

This word with a warning triangle indicates that minor personal injury may occur

▪ if the stated precautionary measures are not taken.

WARNING!

Warning

This word with a warning triangle means there may be a considerable risk of fatal injury

▪ if the stated precautionary measures are not taken.

DANGER!

Danger

This word with a warning triangle indicates that there is a considerable risk of fatal injury

▪ if the stated precautionary measures are not taken.

Information

Information indicates important information about the product or serves to emphasize a section in the documentation that
deserves special attention from the reader.
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2.7.2 Markup of text elements
Certain elements of the continuous text are distinguished as follows.

Important information Words or expressions with a special meaning

Interpolated position mode Optional: File or product name or other name

Detailed information Internal cross-reference

http://www.samplelink.com External cross-reference

Software and other displays

The following formatting is used to identify the various information content of elements referenced by the software
interface or a drive controller display, as well as any user entries.

Main menu 
Settings

Window names, dialog box names, page names or buttons, combined
proper nouns, functions referenced by the interface

Select 
Referencing method A

Predefined entry

Save your 
<own IP address>

User-defined entry

EVENT 52: 
COMMUNICATION

Displays (status, messages, warnings, faults)

Keyboard shortcuts and command sequences or paths are represented as follows.

[Ctrl], [Ctrl] + [S] Key, key combination

Table > Insert table Navigation to menus/submenus (path specification)

2.7.3 Mathematics and formulas
The following signs are used to represent mathematical relationships and formulas.

– Subtraction

+ Addition

× Multiplication

÷ Division

| | Absolute value

http://www.stoeber.de
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2.8 Trademarks
The following names used in connection with the device, its optional equipment and its accessories are trademarks or
registered trademarks of other companies:

EnDat® EnDat® and the EnDat® logo are registered trademarks of Dr. Johannes Heidenhain
GmbH, Germany.

PLCopen® PLCopen® is a registered trademark of the PLCopen Organisation, Netherlands.

PROFIBUS®, 
PROFINET®

PROFIBUS® and PROFINET® are registered trademarks of PROFIBUS
Nutzerorganisation e.V., Germany.

PROFIdrive®,
PROFIsafe®

PROFIdrive® and PROFIsafe® are registered trademarks of Siemens AG, Germany.

SIMATIC®, 
TIA Portal®

SIMATIC® and TIA Portal® are registered trademarks of Siemens AG, Germany.

All other trademarks not listed here are the property of their respective owners.

Products that are registered as trademarks are not specially indicated in this documentation. Existing property rights
(patents, trademarks, protection of utility models) are to be observed.

2.9 Explanation of terms
As relevant standards and products of other manufacturers are referenced, different manufacturer- or standard-specific
names are used for the same term in this documentation.

For improved understandability, the names in this documentation are standardized to the terminology of STOBER to the
greatest extent possible. The correlation of STOBER names to other sources can be found in the following table.

STOBER PROFINET

Controller IO controller

Drive controller IO device

Tab. 1: Correlation of STOBER terminology to PROFINET

STOBER PROFIdrive

Motion block operating mode Program mode

Command operating mode MDI mode

Referencing Homing

Jog Jogging

Tab. 2: Correlation of STOBER terminology to PROFIdrive
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3 Safety notes

WARNING!

Risk of fatal injury if safety notes and residual risks are not observed!

Failure to observe the safety notes and residual risks in the drive controller documentation may result in accidents causing
serious injury or death.

▪ Observe the safety notes in the drive controller documentation.

▪ Consider the residual risks in the risk assessment for the machine or system.

WARNING!

Malfunction of the machine due to incorrect or modified parameterization!

In the event of incorrect or modified parameterization, malfunctions can occur on machines or systems which can lead to
serious injuries or death.

▪ Observe the security notes in the drive controller documentation.

▪ Protect the parameterization, e.g. from unauthorized access.

▪ Take appropriate measures for possible malfunctions (e.g. emergency off or emergency stop).
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4 What you should know before commissioning
The following chapters provide a quick introduction to the structure of the program interface and accompanying window
designations as well as relevant information about parameters and generally saving your project configuration.

4.1 Program interfaces
The following chapters include an overview of the program interfaces for the described software components.

4.1.1 DS6 program interface
Using the graphical interface of the DriveControlSuite commissioning software (DS6), you can project, parameterize and
commission your drive project quickly and efficiently. In case of service, you can evaluate diagnostic information such as
operating states, fault memories and fault counters of your drive project using DriveControlSuite.

Information

The program interface of DriveControlSuite is available in German, English and French. To change the language of the
program interface, select Settings > Language.

Information

The DriveControlSuite help in the menu bar can be reached via Help > Help for DS6 or via the [F1] key on your keyboard.
When you press [F1] in an area of the program, the corresponding help topic opens.
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Fig. 1: DS6: Program interface

No. Area Description

1 Menu bar Using the File, View, Settings and Window menus, you can open and save projects, display
and hide program windows, select the interface language and access level and change
between different windows in the workspace.

2 Toolbar The toolbar enables quick access to frequently needed functions, like opening and saving
projects and hiding and displaying windows in the program interface.

3 Project tree The project tree forms the structure of your drive project in the form of modules and drive
controllers. Select an element using the project tree first in order to edit it using the
project menu.

4 Project menu The project menu offers you various functions for editing the project, module and drive
controller. The project menu adapts to the element that you selected in the project tree.

5 Workspace The different windows which can be used to edit your drive project, such as the
configuration dialog, wizards, the parameter list or the scope analysis tool, open in the
workspace.

6 Parameter check The parameter check points out irregularities and inconsistencies that were detected in
the plausibility check of calculable parameters.

7 Messages The entries in the messages log the connection and communication status of the drive
controllers, incorrect inputs caught by the system, errors when opening a project or rule
violations in the graphical programming.

8 Variable parameter
lists

You can use variable parameter lists to compile any parameters in individual parameter
lists for a quick overview.

9 Status bar In the status bar, you can find the specifications of the software version and get additional
information about the project file, the devices and the progress of the process during
processes such as loading projects.
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4.1.1.1 Configuring the view

In DriveControlSuite, you can change the visibility and arrangement of areas and windows, such as to optimize the available
space in the workspace when working with smaller screens.

Showing/hiding areas

Use the icons in the toolbar or the items in the View menu to show or hide specific areas in DriveControlSuite as needed.

Icon Item Description

– Reset Resets the view to factory settings.

Project Shows/hides the Project window (project tree, project
menu).

Messages Shows/hides the Messages window.

Parameter check Shows/hides the Parameter check window.

Variable parameter lists Shows/hides the Variable parameter lists window.

Arrange and group areas

You can undock and rearrange the individual areas via drag and drop. If you drag an undocked window to the edge of
DriveControlSuite, you can release it there in a color-highlighted area either next to or on top of another window to redock
it.

When you release the window onto another window, the two areas are merged into one window where you can use tabs to
switch between the areas.
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4.1.1.2 Navigation using sensitive circuit diagrams

Fig. 2: DriveControlSuite: Navigation using text links and symbols

In order to graphically illustrate the processing sequence of actual and set values, the use of signals or the arrangement of
drive components and to make configuring the accompanying parameters easier, they are displayed on the respective
wizard pages of the workspace in the form of circuit diagrams.

Blue text links or clickable icons indicate links within the program. These refer to the corresponding wizard pages and, as a
result, allow you to reach additional helpful detail pages with a click.
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4.1.2 TIA Portal program interface
The Siemens Totally Integrated Automation Portal (TIA Portal) offers a platform you can use to commission your PROFINET
system. The TIA Portal is broken down into the portal view and the project view.

TIA portal view

The TIA overall functionality is broken down into different task areas that you can reach using portals. The following graphic
shows the interface elements of the TIA portal view relevant to this documentation.

1 2

3

Fig. 3: TIA Portal: Program interface of the portal view

No. Area Description

1 Portal selection The portal selection offers you access to various portals for different tasks and functions.

2 Portal functions Depending on the selected portal, the portal functions are available here.

3 Project view The button lets you change to the project view.
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TIA project view

The TIA project view offers you access to all components of a project. The following graphic shows the TIA project view
interface elements relevant to this documentation.

1

2

3

4

5

6

Fig. 4: TIA Portal: Program interface of the project view

No. Area Description

1 Project navigation Project navigation offers you access to all components of your TIA project.

2 Details view The details view shows you additional information about a selected object.

3 Workspace In the workspace, you can edit objects in the topology view, network view or device view,
for example.

4 Inspector window The inspector window shows you additional information about a selected object.

5 Task cards Task cards are available depending on the selected object and grant you access to the
hardware catalog, online tools, tasks or libraries, for example.

6 Portal view The button lets you change to the portal view.
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4.2 Meaning of parameters
You can use parameters to adapt the function of the drive controller to your individual application. In addition, parameters
visualize the current actual values (actual velocity, actual torque, etc.) and trigger actions such as Save values, Test phase,
etc.

Interpretation of parameter identification

Parameter identification consists of the following elements, where short forms are also possible, i.e. only specifying a
coordinate or the combination of coordinate and name.

E50 V0

Coordinate Name Version

Drive controller G6

Drive controller
generation/series

4.2.1 Parameter groups
Parameters are assigned to individual groups by topic. The drive controllers differentiate between the following parameter
groups.

Group Topic

 A Drive controllers, communication, cycle times

B Motor

C Machine, velocity, torque/force, comparators

D Set value

E Display

F Terminals, analog and digital inputs and outputs, brake

G Technology – Part 1 (application-dependent)

H Encoder

I Motion (all motion settings)

J Motion blocks

K Control panel

L Technology – Part 2 (application-dependent)

M Profiles (application-dependent)

N Additional functions (application-dependent; e.g. extended cam control unit)

P Customer-specific parameters (programming)

Q Customer-specific parameters, instance-dependent (programming)

R Production data for the drive controller, motor, brakes, motor adapter, gearbox and geared motor

S Safety (safety technology)

T Scope

U Protection functions

Z Fault counter

Tab. 3: Parameter groups
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4.2.2 Parameter types and data types
In addition to topic-based sorting in individual groups, all parameters belong to a certain data type and parameter type. The
data type of a parameter is displayed in the parameter list, properties table. The connections between parameter types,
data types and their value range can be found in the following table.

Data type Parameter type Length Value range (decimal)

INT8 Integer or selection 1 byte (signed) -128 – 127

INT16 Integer 2 bytes (1 word, signed) -32768 – 32767

INT32 Integer or position 4 bytes (1 double word,
signed)

-2 147 483 648 – 2 147 483 647

BOOL Binary number 1 bit (internal: 
LSB in 1 byte)

0, 1

BYTE Binary number 1 byte (unsigned) 0 – 255

WORD Binary number 2 bytes (1 word, unsigned) 0 – 65535

DWORD Binary number or
parameter address

4 bytes (1 double word,
unsigned)

0 – 4 294 967 295

REAL32
(single type according to
IEE754)

Floating-point number 4 bytes (1 double word,
signed)

-3.40282 × 1038 – 3.40282 × 1038

STR8 Text 8 characters —

STR16 Text 16 characters —

STR80 Text 80 characters —

Tab. 4: Parameters: Data types, parameter types, possible values

Parameter types: Use

§ Integer, floating-point number
For general computing processes
Example: Set and actual values

§ Selection
Numeric value to which a direct meaning is assigned
Example: Sources for signals or set values

§ Binary number
Bit-oriented parameter information that is collected in binary
Example: Control and status words

§ Position
Integer combined with associated units and decimal places
Example: Actual and set values of positions

§ Velocity, acceleration, deceleration, jerk
Floating-point number combined with associated units
Example: Actual and set values for velocity, acceleration, deceleration, jerk

§ Parameter address
Referencing of a parameter
Example: In F40 AO1 source, for example, E08 n-motor filtered can be parameterized

§ Text
Outputs or messages
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4.2.3 Parameter types
The following types of parameters are differentiated.

Parameter type Description Example

Simple parameters Consist of one group and one line with a
defined value.

A21 Brake resistor R: Value = 100 ohms

Array parameters Consist of a group, a line and multiple
sequential (listed) elements, which have the
same properties but different values.

A10 Access level

§ A10[0] access level: Value = Access level
via operating unit

§ A10[2] access level: Value = Access level
via CANopen and EtherCAT

§ A10[4] access level: Value = Access level
via PROFINET

Record parameters Consist of a group, a line and multiple
sequential (listed) elements, which can have
different properties and different values.

A00 Save values

§ A00[0] Start: Value = Start action

§ A00[1] Progress: Value = Display action
progress

§ A00[2] Result: Value = Display action
result

Tab. 5: Parameter types

4.2.4 Parameter structure
Every parameter has specific coordinates with the following structure.

E250 [2] .3

Axis
Group

Line

1.

Element
Bit

§ Axis (optional)
In case of multiple axes, the one to which a parameter is assigned; not applicable for global parameters 
(value range: 1 – 4).

§ Group
The thematic group to which a parameter belongs (value range: A – Z).

§ Line
Distinguishes the parameters within a parameter group (value range: 0 – 999).

§ Element (optional)
Elements of an array or record parameter (value range: 0 – 16000).

§ Bit (optional)
Selection of a single bit for complete data addressing; depends on the data type (value range: 0 – 31).
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4.2.5 Parameter visibility
The visibility of a parameter is controlled by the access level you set in DriveControlSuite and by the properties you project
for the respective drive controller (e.g. hardware, firmware and application). A parameter can also be shown or hidden
depending on other parameters or settings. For example, the parameters of an additional function are only shown as soon
as you activate the relevant additional function.

Access level

The access options for the individual software parameters are ranked hierarchically and divided into individual levels. This
means that parameters can be hidden for a specific purpose and, relatedly, their configuration options can be locked
starting from a specific level.

Each parameter has one access level for read access (visibility) and one access level for write access (editability). The
following levels are present:

§ Level 0
Elementary parameters

§ Level 1
Important parameters of an application

§ Level 2
Important parameters for service with extensive diagnostic options

§ Level 3
All parameters needed for commissioning and optimizing an application

The parameter A10 Access level controls general access to parameters:

§ Over CANopen or EtherCAT (A10[2])

§ Over PROFINET (A10[3])

Hardware

Which parameters are available to you in DriveControlSuite is determined by which series you select in the configuration
dialog for the drive controller, for example, or whether you project an option module. Basically, the only parameters that
are displayed are the ones you need to parameterize the configured hardware.

Firmware

Due to the further development and updating of functions for the drive controllers, new parameters and also new versions
of existing parameters are continuously being implemented in DriveControlSuite and in the firmware. The parameters are
displayed in the software according to the DriveControlSuite version used and the configured firmware version of the
respective drive controller.

Applications

Applications generally differ in terms of functions and their control. For this reason, different parameters are available with
each application.

Information

If a parameter exists in the configuration due to the projected properties of the drive controller (e.g. hardware, firmware,
application), it is generally available for fieldbus communication. The visibility of a generally available parameter has no
effect on its availability for fieldbus communication (e.g. through access level or parameter selection).
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4.3 Signal sources
Drive controllers are controlled either by a fieldbus, by terminals or by mixed operation consisting of a fieldbus system and
terminals. You can use the corresponding selection parameters, referred to as signal sources, to configure in
DriveControlSuite whether the control signals and set values of the application are obtained over a fieldbus or using
terminals.

In case of activation by using terminals, the respective analog or digital inputs are specified directly as the source. In case of
activation by fieldbus, parameters are selected as sources for control signals and set values, which must be part of the
process data mapping between the controller and drive controller so that the controller can write to them via fieldbus.

4.4 Non-volatile memory
All project configurations, parameterizations and related changes to parameter values are in effect after transmission to the
drive controller, but are only stored in volatile memory.

Saving to a drive controller

To save the configuration in non-volatile memory on a drive controller, you have the following options:

§ Saving the configuration using the Save values wizard:
Project menu > Wizards area > Projected axis > Save values wizard:
Select the Save values action

§ Saving the configuration using the parameter list:
Project menu > Parameter list area > Projected axis > Group A: Drive controller > A00 Save values:
Set the parameter A00[0] to the value 1: Active

§ Saving the configuration using the S1 operating button:
Press and hold the operating button for 3 s

Saving to all drive controllers within a project

To save the configuration in non-volatile memory on several drive controllers, you have the following options:

§ Saving the configuration using the toolbar:
Toolbar > Save values icon: Click the Save values icon

§ Saving the configuration using the Online functions window:
Project menu > Online connection button > Online functions window: Click on Save values (A00)

Information

Do not shut off the drive controller while saving. If the supply voltage to the control unit is interrupted while saving, the
drive controller will start with the last correct configuration that was saved and with fault 40: Invalid data the next time it is
switched on. In order to acknowledge the fault and successfully complete the saving process, the configuration must be
stored again in non-volatile memory and the action must be completed.
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5 Commissioning
The following chapters describe the commissioning of a PROFINET network, consisting of a Siemens controller and multiple
STOBER drive controllers, with the help of DriveControlSuite and the Siemens TIA Portal.

We assume the following system environment as an example so that you can follow the individual commissioning steps
better:

§ Drive controllers from the SC6 or SI6 series with firmware version 6.7-A-PN or later

§ DriveControlSuite commissioning software in V 6.7-A or later

in conjunction with

§ Siemens SIMATIC S7-1500 controller

§ Siemens Totally Integrated Automation Portal (TIA Portal) automation software in V16 or later

Commissioning is divided into the following steps:

1. First, define the control for the drive controllers.

2. DriveControlSuite:
Next, project all drive controllers of your PROFINET network (device control, application and process data),
parameterize all general PROFINET settings and the motor, as well as the axis model or reference speed if any, and
transmit your configuration to the drive controllers of your PROFINET network.

3. TIA Portal:
Next, map your real PROFINET network in TIA Portal, configure the individual nodes and parameterize the activation
of the drive controllers. Transfer the configuration to the controller and start up your PROFINET network.

Information

Before you start commissioning your PROFINET network using DriveControlSuite and TIA Portal, you must network all nodes
of your PROFINET network with each other.
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5.1 Setting the control
The options described below are available for controlling STOBER drive controllers via TIA Portal.

Siemens technology objects (TO)

Technology object Description Application

TO_SpeedAxis Control of a velocity-controlled axis Controller-based application

TO_PositioningAxis,
TO_SynchronousAxis

Control of a position-controlled axis Controller-based application

TO_BasicPos Control of a position-controlled axis Drive-based application

Tab. 6: Siemens technology objects

You can access the technology objects directly in TIA Portal and add them to your controller.

Siemens function blocks (FB) from the DriveLib

Function block Description Application

FB SINA_SPEED Control of a velocity-controlled axis Drive-based application

FB SINA_POS Control of a position-controlled axis Drive-based application

Tab. 7: Siemens function blocks DriveLib

The function blocks can be downloaded free of charge from the Siemens website after registration and imported into TIA
Portal (https://support.industry.siemens.com). If you are already using the function blocks in TIA Portal, make sure that you
are working with the latest version.

Possible combinations

The following table shows examples of possible combinations of technology objects or function blocks with the available
application classes and telegrams.

During commissioning in TIA Portal, you will learn how to configure your control system based on these examples.

Control Application class Telegrams

TO_SpeedAxis AC1 Standard telegrams 1, 2, 3

TO_PositioningAxis,
TO_SynchronousAxis

AC4 Standard telegrams 3, 5 or Siemens telegrams 102, 105 (optionally in
combination with Siemens additional telegram 750)

TO_BasicPos AC3 Siemens telegram 111

FB SINA_SPEED AC1 Standard telegram 1

FB SINA_POS AC3 Siemens telegram 111

Tab. 8: Combinations: function block or technology object with telegram

For more information on application classes and telegrams, see Application classes and telegrams in detail [} 69].

Information

This documentation focuses on the device-specific settings that must be considered for drive controllers from STOBER for
parameterizing technology objects from Siemens or controlling function blocks. For settings that are not described in detail,
refer to the Siemens documentation.

https://support.industry.siemens.com
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5.2 DS6: Configuring the drive controller
Project and configure all drive controllers for your drive system in DriveControlSuite (see also DS6 program interface [} 11]).

Information

Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.

5.2.1 Initiating the project
In order to be able to configure all drive controllers and axes of your drive system using DriveControlSuite, you must record
them as part of a project.

5.2.1.1 Projecting the drive controller and axis

Create a new project and project the first drive controller along with the accompanying axis.

Information

Make sure that you project the correct series in the Drive controller tab. The projected series cannot be changed
afterwards.

Creating a new project

1. Start DriveControlSuite.

2. On the start screen, click Create new project.

ð The new project is created and the configuration dialog for the first drive controller opens.

ð The Drive controller button is active.
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Projecting the drive controller

1. Properties tab: 
Establish the relationship between your circuit diagram and the drive controller to be projected in DriveControlSuite.

1.1. Reference:
Define the reference code (equipment code) of the drive controller.

1.2. Designation:
Give the drive controller a unique name.

1.3. Version:
Version your project configuration.

1.4. Description:
If necessary, save additional supporting information (e.g., the change history).

2. Drive controller tab:
Select the series, device type and firmware version of the drive controller.

2.1. Firmware:
Select the PROFINET version 6.x -PN.

3. Option modules tab, Safety module:
If the drive controller is part of a safety circuit, select the corresponding safety module.

4. Device control tab:
Project the basic control of the drive controller.

4.1. Device control:
Select PROFIdrive device control.

4.2. Rx process data, Tx process data:
Select PROFINET Rx and PROFINET Tx for transmitting PROFINET process data.

Projecting the axis

1. Click Axis A.

2. Properties tab: 
Establish the relationship between your circuit diagram and the axis to be projected in DriveControlSuite.

2.1. Reference:
Define the reference code (equipment code) of the axis.

2.2. Designation:
Give the axis a unique name.

2.3. Version:
Version your project configuration.

2.4. Description:
If necessary, save additional supporting information (e.g., the change history).

3. Application tab:
Select the PROFIdrive application.

4. Motor tab:
Select the type of motor you operate with this axis. If you are working with motors from third-party suppliers, enter
the accompanying motor data later.

5. Repeat the steps for axis B (only for double-axis controllers).

6. Confirm with OK.
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5.2.1.2 Configuring safety technology

If the drive controller is part of a safety circuit, you must configure the safety technology in accordance with the
commissioning steps outlined in the corresponding manual in the next step (see Further information [} 148]).

5.2.1.3 Creating other drive controllers and modules

In DriveControlSuite, all drive controllers within a project are grouped using modules. If you add a new drive controller to
your project, be sure to always assign it to an existing module. Group drive controllers in a module if, for example, they are
located in the same control cabinet or work together to operate the same machine part.

Creating a drive controller

1. In the project tree, select your project P1 > module M1 > context menu Create new drive controller.

ð The drive controller is created in the project tree and the configuration dialog opens.

2. Project the drive controller as described in Projecting the drive controller and axis.

3. Repeat the steps for all other drive controllers that you want to project.

Creating a module

1. In the project tree, select your project P1 > context menu Create new module.

ð The module is created in the project tree.

2. Project the module as described in Projecting the module [} 26].

3. Repeat the steps for all other modules that you want to project.

5.2.1.4 Projecting the module

Give your module a unique name, enter the reference code and, as an option, store additional information like the version
and change history of the module.

1. Select the module in the project tree and click on Project configuration in the project menu.

ð The configuration dialog for the module opens.

2. Establish the relationship between your circuit diagram and the module in DriveControlSuite.

2.1. Reference:
Define the reference code (equipment code) of the module.

2.2. Designation:
Give the module a unique name.

2.3. Version:
Version the module.

2.4. Description:
If necessary, save additional supporting information (e.g., the change history).

3. Confirm with OK.
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5.2.1.5 Projecting the project

Give your project a unique name, enter the reference code and, as an option, store additional information like the version
and change history of the project.

1. Select the project in the project tree and click on Project configuration in the project menu.

ð The configuration dialog for the project opens.

2. Establish the relationship between your circuit diagram and the project in DriveControlSuite.

2.1. Reference:
Define the reference code (equipment code) of the project.

2.2. Designation:
Give the project a unique name.

2.3. Version:
Version the project.

2.4. Description:
If necessary, save additional supporting information (e.g., the change history).

3. Confirm with OK.

5.2.2 Parameterizing general PROFINET settings

ü You have projected the PROFINET Rx and PROFINET Tx process data for the drive controller.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the PROFINET wizard.

3. A100 Fieldbus scaling:
Leave the default value at 1: Native (values are passed unchanged).

4. A273 PN device name:
Elements [0] to [2] show the PROFINET device name that was assigned in TIA Portal if there is an online connection
between the drive controller and controller.
In elements [3] to [5], you have the option to enter the device name. This eliminates the need to assign the device
name in TIA Portal.

5. A109 PZD-Timeout:
Define the time that results from the tolerated failure time for monitoring the PZD communication plus the watchdog
time of the controller (TIA Portal: watchdog time) in the PROFINET network (default value: 20 ms).
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5.2.3 Configuring PZD transmission
The PZD channel (process data transmission channel) serves to transfer control and status information as well as actual and
set values between a controller (IO controller) and drive controller (IO device) cyclically in real time. The direction of data
flow is important in this data exchange. From the perspective of the drive controller, PROFINET distinguishes between
receive PZD (RxPZD) and transmit PZD (TxPZD). STOBER drive controllers support a flexible assignment of the parameter
values to be transmitted.

In the PROFIdrive application, all parameters for mapping the process data are configured automatically during start-up of
PROFINET depending on the telegram specified by the controller. You do not need to set these parameters manually.

5.2.4 Parameterizing the motor
You have projected one of the following motors:

Synchronous servo motor with EnDat 2.2 digital encoder or EnDat 3 (with optional brake)

When the project is configured for the corresponding motor, limiting values for currents and torques as well as associated
temperature data are automatically transferred to the respective parameters of the individual wizards. All additional data
on the brake and encoder is transferred at the same time.

Lean motor without encoder (with optional brake)

When the project is configured for the corresponding motor, limiting values for currents and torques as well as associated
temperature data are automatically transferred to the respective parameters of the individual wizards. You only have to
parameterize the cable length in use and the mass inertia ratio of the load to the motor. Even the brake purging and
engaging times are already stored. You just have to activate the brake.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Motor wizard.

3. B101 Cable length:
Select the cable length of the power cable in use.

4. Select the Control cascade wizard > Control mode.

5. C30 J-Last / J-Motor:
Parameterize the mass inertia ratio of the load to the motor.

6. Repeat the steps for the 2nd axis (only for double-axis controllers).

Then activate the brake.

1. Select the relevant drive controller in the project tree and click on the first projected axis in the Project menu > Wizard
area.

2. Select the Brake wizard.

3. F00 Brake:
Select 1: Active.

4. Repeat the steps for the 2nd axis (only for double-axis controllers).
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5.2.5 Mapping the mechanical axis model
For a control in combination with telegram 111, you must map your complete mechanical environment in DriveControlSuite
to be able to commission your real drive train with one or more drive controllers.

For all other telegrams, do not make any changes to the axis model. Instead, parameterize the required limits directly in the
next step (see Parameterizing the reference speed [} 34]).

5.2.5.1 Parameterizing the axis model

Parameterize the setup of your drive in this order:

§ Define the axis model

§ Scale the axis

§ Parameterize the position and velocity window

§ Limit the axis (optional)

• Limit the position

• Limit the velocity, acceleration and jerk

• Limit the torque and force

Information

If you are using a double-axis controller with two projected axes, you must parameterize the axis model for each axis
individually.
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5.2.5.1.1 Define the axis model

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard.

3. I05 Type of axis:
Define whether the axis type is rotational or translational.

3.1. If you would like to configure the units of measure and the number of decimal places individually for specifying
and displaying positions, velocities, accelerations and jerk, select 0: User defined, rotational or 1: User defined,
translational.

3.2. If the units of measure and the number of decimal places for specifying and displaying positions, velocities,
accelerations and jerk are to be fixed, select 2: Rotational or 3: Translational.

4. B26 Motor encoder:
Select the interface to which the motor encoder is connected.

5. I02 Position encoder (optional):
Select the interface to which the position encoder is connected.

6. I00 Position range:
Select whether the travel range of the axis is limited or endless (modulo).

Information

When you parameterize I05 Type of axis, you can either use selection 0: User defined, rotational or 1: User defined,
translational to configure units of measure and the number of decimal places for the axis model individually or use
selections 2: Rotational and 3: Translational to revert to preset values.

Selection 0: User defined, rotational and selection 1: User defined, translational let you configure the unit of measure (I09)
and the decimal places (I06) individually. Velocity, acceleration and jerk are represented as the derivative of the unit of
measure with respect to time.

Selection 2: Rotational sets the following units of measure for the axis model: position in °, velocity in rpm, acceleration in
rad/s2, jerk in rad/s3.

Selection 3: Translational sets the following units of measure for the axis model: position in mm, velocity in m/s,
acceleration in m/s2, jerk in m/s3.

Information

If you do not parameterize it differently for I02 Position encoder, B26 Motor encoder is used for position control as
standard.



STÖBER 5 | Commissioning
11

/2
02

5 
| 

ID
 4

43
27

0.
04

31

5.2.5.1.2 Scale the axis

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard > Axis: Scaling.

3. Scale the axis by configuring the overall gear ratio between the motor and output.
To simplify this scaling for you, you are provided with the scaling calculator Conversion of positions, velocities,
accelerations, torque/force, which calculates the effects of changed motion variables on the entire system.

4. I01 Circular length:
If you have selected 1: Endless = I00 Position range, define the revolution length.

5. I06 Decimal places position (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for I05 Type of axis, define the desired
number of decimal places.

6. I09 Measure unit (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for I05 Type of axis, define the desired
unit of measure.

7. I03 Axis polarity:
Use the polarity to define the direction of interpretation between the axis movement and motor movement.

Information

A change to parameter I06 moves the decimal separator for all axis-specific position values! Ideally, define I06 before
parameterizing other position values and then check them.

If the axis receives set value specifications from a controller or follows the master values of a master, the resolution of
position values directly impacts the smooth operation of the axis. Therefore, you should define a sufficient number of
decimal places appropriate for your application.

Information

Parameter I297 Maximum speed position encoder must be parameterized according to your application case. If I297 is set
too low, the permitted maximum speed is exceeded even at normal operating speeds. On the other hand, if I297 is set too
high, measuring errors of the encoder can be overlooked.

I297 depends on the following parameters: I05 Type of axis, I06 Decimal places position, I09 Measure unit as well as
I07 Distance factor numerator position and I08 Distance factor denominator position or A585 Feed constant for CiA 402. If
you have made changes to one of the parameters listed, select I297 accordingly as well.
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5.2.5.1.3 Parameterizing the position and velocity window

Enter position limits and velocity zones for set values. To do so, parameterize boundary values for reaching a position or
velocity.

1. Select the Axis model wizard > Window position, velocity.

2. C40 Velocity window:
Parameterize a tolerance window for velocity tests.

3. I22 Target window:
Parameterize a tolerance window for position tests.

4. I87 Actual position in window time:
Parameterize how long a drive must stay in the specified position window before a corresponding status message is
output.

5. I21 Maximal following error:
Parameterize a tolerance window for lag tests.

For more information on monitoring the lag, see Lag monitoring [} 145].

5.2.5.1.4 Limiting the axis

As an option, you can limit the maximum permitted motion variables of position, velocity, acceleration, jerk and torque/
force according to your application.

Information

To simplify the scaling and limiting of the axis, the Axis model wizard > Axis: Scaling provides you with the Conversion of
position, velocities, accelerations, torque/force scaling calculator, which calculates the effects of changed motion variables
on the entire system. You can use the scaling calculator to enter values for motion variables of the motor, gearbox output
and axis in order to convert the values to all other locations in the axis model.

Limiting the position

To secure the travel range of the axis, you have the option to limit the permitted positions using a software or hardware
limit switch.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Axis model wizard > Limit: Position.

3. I101 Source positive /limit switch, I102 Source negative /limit switch:
To limit the travel range of the axis in the positive or negative direction of motion via hardware limit switches, select
the source of the digital signal that is used to evaluate a limit switch at the positive or negative end of the travel range.

3.1. If bit 1 or bit 2 of the control word I210 of the application is the source, select 2: Parameter.

3.2. If a digital input (direct or inverted) acts as the source, select the corresponding input.

4. I50 Software stop positive, I51 Software stop negative:
If you selected 0: Limited for I00 and would like to limit the travel range of the axis via software limit switches, define
the largest or smallest permitted position for software position limiting.
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ATTENTION!

Material damage due to leaving the permitted travel range

When a limit switch is overshot, the axis at the end of the permitted travel range will go into a fault condition, either with
or without a quick stop depending on the parameterization of the device control, so it may come to a standstill past the
limit switch and outside the permitted travel range.

▪ Allow sufficient space past the limit switch for your application to bring the axis to a standstill.

Limiting velocity, acceleration, jerk

As an option, you can limit the motion variables of velocity, acceleration and jerk and define the quick stop deceleration
according to your application. The default values are designed for slow velocities without gearboxes.

1. Select the Motor wizard.

2. B83 v-max motor:
Determine the maximum permitted velocity of the motor.

3. Select the Axis model wizard > Axis: Scaling.

4. Conversion of positions, velocities, accelerations, torque/force area:
Use the scaling calculator to determine the maximum permitted velocity of the motor and the maximum permitted
velocity of the output as a reference value.

5. Select the Axis model wizard > Limit: Velocity, acceleration, jerk.

6. I10 Maximal speed:
Define the maximum permitted velocity of the output according to your application (taking into account the
previously determined reference value).

7. I11 Maximal acceleration:
Define the maximum permitted acceleration for the output.

8. I16 Maximal jerk:
Define the maximum permitted jerk for the output.

9. I17 Quickstop deceleration: 
Define the desired quick stop deceleration for the output.

10. Repeat the steps for axis B (only for double-axis controllers).

Limiting the torque/force

As an option, you can limit the torque/force according to your application. The default values take into account the rated
operation together with the overload reserves.

1. Select the Axis model wizard > Limit: Torque/force.

2. C03 Maximum positive torque/force, C05 Maximum negative torque/force:
Define the maximum permitted set torque/maximum permitted set force.

3. C08 Maximum torque/force for quick stop:
Define the maximum permitted set torque/maximum permitted set force in case of a quick stop and in case of drive-
controlled emergency stop SS1, SS1 and SS2.
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5.2.6 Parameterizing the reference speed
Parameterize the reference value for the set and actual velocities as described below in order to ensure the function of the
application. For control in combination with telegram 111, the reference value is not evaluated and parameterization is
therefore not required.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Application PROFIdrive wizard > Additional functions > Drive data.

3. Reference speed in user unit:
Define the reference value for the target and actual velocities.

4. Repeat the steps for axis B (only for double-axis controllers).

Limiting velocity, acceleration, jerk

As an option, you can limit the motion variables of velocity, acceleration and jerk and define the quick stop deceleration
according to your application. The default values are designed for slow velocities without gearboxes.

1. Select the Motor wizard.

2. B83 v-max motor:
Determine the maximum permitted velocity of the motor.

3. Select the Axis model wizard > Axis: Scaling.

4. Conversion of positions, velocities, accelerations, torque/force area:
Use the scaling calculator to determine the maximum permitted velocity of the motor and the maximum permitted
velocity of the output as a reference value.

5. Select the Axis model wizard > Limit: Velocity, acceleration, jerk.

6. I10 Maximal speed:
Define the maximum permitted velocity of the output according to your application (taking into account the
previously determined reference value).

7. I11 Maximal acceleration:
Define the maximum permitted acceleration for the output.

8. I16 Maximal jerk:
Define the maximum permitted jerk for the output.

9. I17 Quickstop deceleration: 
Define the desired quick stop deceleration for the output.

10. Repeat the steps for axis B (only for double-axis controllers).

Information

When you set the corresponding parameters on the controller side during commissioning in TIA Portal, note that some
units on the drive controller and controller side may be different.

Parameter DriveControlSuite Condition TIA Portal parameter

M571 Velocity reference value 
(reference speed in user unit)

= Reference speed

Reference torque (C09 × 2.5) = Reference torque

I10 Maximal speed ≥ Maximum permitted velocity

I11 Maximal acceleration ≥ Maximum permitted acceleration/deceleration

I16 Maximal jerk ≥ Maximum permitted jerk

I17 Quickstop deceleration ≥ Emergency deceleration

Tab. 9: Limits: Required parameters on drive controller and controller sides
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5.2.7 Referencing the absolute position
When commissioning a system with position measurement systems, the relation of a measured to an actual axis position
must be determined to be able to work with absolute positions.

For a control in combination with telegram 111, you must reference your drive if you are working with absolute positions.
For all other controls, this step is not necessary. In this case, transfer and save the configuration (see Transmitting and
saving the configuration [} 36]).

Information

If you are using a double-axis controller with two projected axes, you must reference the absolute position for each axis
individually.

5.2.7.1 Defining the referencing method

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Referencing wizard.

3. I30 Referencing type, I31 Referencing direction, I35 Referencing with zero pulse:
Define the characteristics for referencing.
For information on possible combinations of the named characteristics as well as detailed descriptions of the
individual referencing methods, see Referencing methods [} 106].

4. I43 Move to reference position:
If the axis is to automatically move to the referenced position after referencing, set this parameter to 1: Active.

5.2.7.2 Parameterizing the reference switch

If you are working with absolute positions and would like to determine a reference position while referencing using the
reference switch, proceed as follows.

1. Select the PROFIdrive application wizard > Data sources > Application digital signals: Data source.

2. I103 Source reference switch:

2.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If bit 3 of the control word I210 of the application is the source, select 2: Parameter.

5.2.7.3 Setting the reference

If you are working with absolute positions and would like to reference without using a referencing run, the value of the
current actual position is applied directly as a parameter value from I34 using the Set reference signal.

1. Select the PROFIdrive application wizard > Data sources > Application digital signals: Data source.

2. I111 Source set reference:

2.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If bit 11 of the control word I210 of the PROFIdrive application is the signal source, select 2: Parameter.
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5.2.8 Transmitting and saving the configuration
In order to transmit and save the configuration to one or more drive controllers, you must connect your PC and the drive
controllers over the network.

WARNING!

Injury to persons and material damage due to axis movement!

If there is an online connection between DriveControlSuite and the drive controller, changes to the configuration can lead
to unexpected axis movements.

▪ Only change the configuration if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Information

During the search, all drive controllers within the broadcast domain are found via IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

ü The drive controllers are switched on and can be found in the network.

1. In the project tree, select the module under which you have recorded your drive controller and click Online
connection in the project menu.

ð The Add connection dialog box opens. All drive controllers found via IPv4 limited broadcast are displayed.

2. Direct connection tab, IP address column: 
Activate the IP addresses in question and confirm your selection with OK.

ð The Online functions window opens. All drive controllers connected through the selected IP addresses are
displayed.

3. Select the module and the drive controller to which you would like to transfer the configuration. Change the selection
of transmission type from Read to Send.

4. Change the selection Create new drive controller:
Select the configuration that you would like to transfer to the drive controller.

5. Repeat steps 3 and 4 for all other drive controllers to which you would like to transfer your configuration.

6. Online tab:
Click Establish online connections.

ð The configurations are transferred to the drive controllers.
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Saving a configuration

ü You have successfully transferred the configuration.

1. Online functions window, Online tab, Actions for drive controller in online operation area:
Click Save values (A00).

ð The Save values (A00) window opens.

2. Select on which drive controllers you want to save the configuration.

3. Click Start action.

ð The configuration is stored on the drive controllers in non-volatile memory.

4. Close the Save values (A00) window.

Information

For the configuration to take effect on the drive controller, a restart may be required in certain cases, such as after the
configuration is saved on the drive controller for the first time or when changes are made to the firmware or process data
mapping.

Restarting a drive controller

ü You have stored the configuration on the drive controller in non-volatile memory.

1. Online functions window, Online tab:
Click Restart (A09).

ð The Restart (A09) window opens.

2. Select which of the connected drive controllers you want to restart.

3. Click Start action.

4. Confirm the safety note with OK.

ð The Restart (A09) window closes.

ð The fieldbus communication and connection between DriveControlSuite and drive controllers are interrupted.

ð The selected drive controllers restart.

5.2.9 Testing the configuration
After you have transferred the configuration to the drive controller, first check your projected axis model and the
parameterized electrical and mechanical data for plausibility before continuing with the parameterization.

Test the configuration for control in combination with telegram 111. For all other telegrams, this step is optional.

Information

Make sure that the values of the control panel are compatible with your projected axis model in order to obtain useful test
results that you can use to optimize your configuration for the respective axis.

The scaling calculator is available under the Axis model wizard > Axis: Scaling to recalculate the values for the control panel
according to your projected axis model.
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WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the motions of the axis. If you are using a
controller, it no longer monitors the axis movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is deactivated, which can cause
unexpected axis movements.

▪ Do not switch to other windows when the control panel is active.

▪ Only use the control panel if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link between you and a person on site with eye
contact to the axis.

Testing the configuration using the jog control panel

ü There is an online connection between DriveControlSuite and the drive controller.

ü You have successfully stored the configuration on the drive controller.

ü No safety function is active.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in the Project menu >
Wizard area.

2. Select the Jog control panel wizard.

3. Click Control panel on and then Enable.

ð The axis is monitored via the active control panel.

4. Check the default values of the control panel and adjust them to your projected axis model if necessary.

5. To test the configuration of your projected axis for direction of motion, velocity, etc., move the axis gradually using
the Jog+, Jog-, Jog step+ and Jog step- buttons.

6. Use your test results to optimize your configuration as necessary.

7. To deactivate the control panel, click on Control panel off.

Information

Jog+ and Jog− cause a continual manual movement in the positive or negative direction. Jog step+ and Jog step- move the
axis relative to the current actual position by the increment specified in I14.

Jog+ and Jog− have a higher priority than Jog step+ and Jog step−.
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5.3 TIA Portal: Setting up a PROFINET network
A PROFINET networks generally consists of a controller (IO controller) and multiple drive controllers (IO devices). Using
TIA Portal, map your real PROFINET network in a TIA project, configure all PROFINET nodes and link them logically with each
other. Then, transfer the configuration to the controller and check the cyclical communication.

Information

Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you have first configured certain settings.
Follow the steps in the specified sequence so that you can finish the parameterization completely.

5.3.1 Installing the GSD file
To be able to map the STOBER drive controllers of your PROFINET network in your TIA project, you must import and install a
GSD file (general station description file) from STOBER in your TIA project. STOBER drive controllers are available in the
hardware catalog of your TIA project as soon as the GSD file has been installed.

Information

If you have already downloaded a GSD file from the STOBER download area at an earlier point, make sure that you are using
the current version of the GSD file required.

ü You have downloaded the current version of the GSD file from the STOBER download area and saved it locally.

ü You have created a TIA project and are in the TIA project view.

1. In the menu bar, select Options > Manage general station description files (GSD).

ð The Manage general station description files window opens.

2. Installed GSDs tab > Source path area:
Select the directory in which you have stored the GSD file from STOBER and confirm with OK.

ð The GSD file is displayed in the Content of the imported path area.

3. Content of the imported path area:
Select the desired GSD file and click on Install.

ð The GSD file is installed; the STOBER drive controllers are available in the hardware catalog.
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5.3.2 Projecting the PROFINET network
Map the controller and all drive controllers of your PROFINET network in a TIA project by selecting the corresponding
modules from the hardware catalog and incorporating them into the project.

5.3.2.1 Projecting the controller

Project the controller of your PROFINET network.

ü You have created a TIA project and installed the GSD file from STOBER.

ü You are in the TIA network view; the hardware catalog is open.

1. Hardware catalog:
Select Controller > SIMATIC S7-1500 > CPU and open the folder of the CPU type that belongs to your controller.

2. Drag and drop the desired controller into the network view.

ð The controller is incorporated into your TIA project.

5.3.2.2 Projecting the drive controller

Project all drive controllers of your PROFINET network.

ü You have created a TIA project and installed the GSD file from STOBER.

ü You are in the TIA network view; the hardware catalog is open.

1. Hardware catalog: 
Select Other field devices > PROFINET IO > Drives > STOBER ANTRIEBSTECHNIK GmbH & Co. KG > STOBER
ANTRIEBSTECHNIK > STOBER 6th generation drive controllers > SI6, SC6 double-axis controllers+ PD3 or SI6, SC6
single-axis controllers + PD3.

2. Drag and drop the desired drive controller into the network view.

ð The drive controller is incorporated into your TIA project.

3. Repeat steps 1 and 2 for all the drive controllers of your PROFINET network.

5.3.2.3 Linking the controller and drive controller logically

Establish a logical gate link between the controller and drive controllers in order to enable the communication between the
devices.

ü You have projected the controller and drive controllers.

ü You are in the TIA network view.

1. Click on the interface of the controller and drag a connection to the interface of the first drive controller while holding
the mouse button.

2. Repeat the process for all drive controllers of your PROFINET network.

ð The controller and drive controllers of your PROFINET network are linked logically with each other.

Information

To be able to link the controller and drive controllers with each other logically, you must be in the TIA network view.
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5.3.2.4 Connecting ports

If you want to implement a control in application class 4, you have to connect the ports of all nodes. For other application
classes, this step is optional.

In order for PROFIdrive to operate in application class 4, PROFINET must be in synchronous operation mode. For
synchronous operation via PROFINET IRT, you must define how all PROFINET nodes are connected to each other in the
connection topology. To do this, in the topology view, specify the connection of each individual cable from device to device
and the exact port.

ü You have logically linked the controller and drive controllers.

ü You are in the TIA topology view.

1. Click on the port you want to connect and drag it to the destination port while holding down the mouse button.

2. Repeat the process for all ports to be connected in your PROFINET network.

ð You have created the port connections.

Information

With an existing online connection, you can compare the connections you have created with your real cable connections.
For more information on the topology comparison, see the documentation from Siemens or the online help in TIA Portal.

5.3.3 Configuring network addresses
As needed, you can change the IP address and subnet mask of the controller.

ü You are in the TIA network view.

1. Double-click on the controller of your PROFINET network.

ð This switches you to the respective device view; the Inspector window shows the device properties.

2. Inspector window > General tab:
Select PROFINET interface > Ethernet addresses in the area navigation.

3. IP protocol area > Set IP address in the project:
If not set by default, activate this option and change the IP address and subnet mask of the controller.

ð The IP address and subnet mask of the controller are configured.
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5.3.4 Configuring the drive controller
Assign a device name for the drive controllers of your TIA project to be able to identify them in the PROFINET network.
Project a telegram for each axis and configure the settings for synchronization afterwards if necessary.

5.3.4.1 Assigning device names

Assign a device name for your drive controllers to be able to identify them in the PROFINET network.

ü You are in the TIA network view.

1. Double-click on a drive controller of your PROFINET network.

ð This switches you to the respective device view; the Inspector window shows the device properties.

2. Inspector window > General tab:
Select General in the area navigation.

3. Name:
Assign a device name for the drive controller that corresponds to the PROFINET naming conventions.

4. Device view:
Select the relevant drive controller and select Assign device name using its context menu.

ð The Assign PROFINET device name window opens.

5. Click on Update list.

ð All drive controllers are listed that were found in the subnet.

ð Depending on the drive controller, the device type, IP address and MAC address are displayed.

6. Mark the drive controller that you would like to name and click on Assign name.

ð The device name is assigned to the selected drive controller.

Information

Alternatively, you can enter the device name in DriveControlSuite in parameter A273[3] to [5]. This eliminates steps 4 to 6
in TIA Portal for assigning the device name.

Information

Using Flash LED, you can identify which drive controller you have currently selected if multiple drive controllers are found in
the same subnet.

As an alternative, you can identify the drive controller by its MAC address. The MAC address of the drive controller can be
read off in parameter A279 PN MAC addresses in DriveControlSuite (PROFINET wizard > Diagnostics).
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5.3.4.2 Projecting a standard telegram

Project a telegram and, if necessary, an additional telegram as described below.

Information

For double-axis controllers, note that mixed operation of the PROFINET RT and PROFINET IRT transmission methods is not
possible. For example, if you project standard telegram 1 in AC1 for axis A and standard telegram 5 in AC4 for axis B,
standard telegram 1 is ignored.

ü You are in the TIA network view; the hardware catalog is open.

1. Double-click on a drive controller of your PROFINET network.

ð This switches you to the respective device view.

2. Hardware catalog:
Select Module > PROFIdrive modules.

3. Drag and drop the PROFIdrive modules module into the device overview of the drive controller at slot 1.

4. Hardware catalog:
Select Module > Submodules.

5. Select a telegram.

6. Drag and drop the selected standard telegram into the device overview of the drive controller at slot 1 2.

7. If you want to use an additional telegram, select it in the hardware catalog.

8. Drag and drop the selected additional telegram into the device overview of the drive controller at slot 1 3.

9. If you are using a double-axis controller, repeat steps 2 through 8 for the second axis and for slots 2, 2 2 and 2 3.
Project a telegram for the second axis even if you are not using it.

ð You have configured the telegrams.

Information

If you project additional telegram 900, define the additional process data that is to be transferred to the controller in
DriveControlSuite via the parameters A92 (RxPZD) and A96 (TxPZD). Elements [0] – [11] are used for axis A parameters and
elements [11] – [23] for axis B parameters. A data length of 12 bytes each is available for the receive and transmit process
data.
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5.3.4.3 Configuring PZD transmission

For process data transmission, configure the cycle time for the data exchange as well as the watchdog time for the
monitoring of PROFINET communication between the controller and drive controller.

ü You are in the TIA network view.

1. Double-click on a drive controller of your PROFINET network.

ð This switches you to the respective device view; the inspector window shows the device properties.

2. Inspector window:
In the area navigation, select PROFINET interface [X1] > Advanced options > Real-time settings > IO cycle.

3. Update time:
Configure the cycle time in which the controller and drive controller exchange data.

3.1. Calculate update time automatically:
If the cycle time is to be calculated automatically, select this option.

3.2. Set update time manually:
If you want to set the cycle time manually, select this option and specify the desired time.

3.3. Adapt update time when send clock changes:
If you have set the cycle time manually and if the ratio between cycle time and transmission cycle is to remain
constant, also select this option.

4. Watchdog time area:
Configure the watchdog time for monitoring the PROFINET communication.

4.1. Accepted update cycles without IO data:
Enter the number of permitted cycles after which the PROFINET watchdog is triggered in case of an
interruption in PROFINET communication.

4.2. Watchdog time:
The watchdog time for PROFINET communication is calculated automatically based on the cycle time and the
permitted cycles without data exchange and must not exceed 1.92 seconds.

Information

The application-dependent cycle time of the drive controller can be read off in parameter A150 Cycle time in
DriveControlSuite.
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5.3.4.4 Setting a drive controller synchronously

Configure the following settings for clock synchronization via PROFINET IRT if you want to implement control in application
class 4. For other application classes, this step is omitted.

ü You are in the TIA network view.

1. Double-click on a drive controller of your PROFINET network.

ð This switches you to the respective device view; the inspector window shows the device properties.

2. Inspector window > General tab:
Select PROFINET interface > Advanced options > Isocronous mode in the area navigation.

3. Isochronous mode for local modules area > Isochronous mode:
Activate the option.

4. Detail overview area:
Activate the submodule with the inserted telegram in the clock synchronization column to assign the synchronized
operation to the telegram.

5. If you are using a double-axis controller, activate the second submodule with the inserted telegram.

ð The times are recalculated and entered in the clock synchronization for local modules area. The transmission cycle
is taken from the GSD file.

ð You have configured the drive controller for synchronized operation.

5.3.5 Control via technology objects
The following chapters describe how to configure the control using technology objects. Add a technology object for an axis
to your controller. Then follow the instructions for the technology object with which you want to operate the
corresponding axis. For information on alternative configuration via a function block, see Control via function blocks
[} 63].

Information

If you are using a double-axis controller, you must configure the technology objects for each axis individually.

5.3.5.1 Adding a technology object

Add a technology object for an axis in the project navigation of your controller.

1. Project tree > Devices tab:
Open the Technology objects folder of the relevant controller in question.

2. Double-click Add new object.

ð The Add new object window opens.

3. Select the desired technology object.

4. Confirm with OK.

ð The new technology object is created and placed in the Technology objects folder.

ð If organization blocks MC-Servo and MC-Interpolator do not yet exist, they are created.
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5.3.5.2 TO_SpeedAxis and telegram 1, 2 or 3

With the TO_SpeedAxis technology object, you can implement the control of a velocity-controlled axis. You can use this
technology object with the standard telegrams 1, 2 or 3.

5.3.5.2.1 Configuring a technology object

Define the hardware interface of the drive and set other parameters required for your application.

Parameterizing the hardware interface

Information

Reference speed, maximum speed and reference torque:
Apply the values from the DriveControlSuite, Application PROFIdrive wizard > Additional functions > Drive data.

ü You have added the TO_SpeedAxis technology object to your controller.

1. Project tree > Devices tab:
Open the folder of the technology object.

2. Double-click to open the configuration of the technology object.

ð This switches you to the corresponding function view.

3. In the area navigation, select Hardware interface > Drive.

4. Drive type:
Select PROFIdrive.

5. Data connection:
Select Drive.

6. Drive:
Select the drive with the telegram submodule already inserted.

7. In the area navigation, select Hardware interface > Data exchange with the drive.

8. Drive data area > Drive telegram:
Select the telegram that corresponds to the telegram of the inserted submodule.

9. Drive data area > Reference speed:
Enter the reference speed for the set velocity.
This must match the value on the drive controller side.

10. Drive data area > Maximum speed:
Enter the maximum permitted speed.
This must match or be smaller than the value on the drive controller side.
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Parameterizing extended parameters

Implement the settings necessary for your application.

ü You are in the TIA function view of the technology object.

1. In the area navigation, select Extended Parameters > Limits > Dynamic limits.

2. Implement the settings necessary for your application.

3. Maximum velocity:
Enter the maximum permitted velocity.
This must match or be smaller than parameter I10 on the drive controller side.

4. Maximum acceleration:
Enter the maximum permitted acceleration.
This must match or be smaller than parameter I11 on the drive controller side.

5. Maximum deceleration:
Enter the maximum permitted delay.
This must match or be smaller than parameter I11 on the drive controller side.

5.3.5.2.2 Programming the control

The TO_SpeedAxis technology object is controlled via the PLCopen blocks MC_POWER, MC_HALT, MC_RESET and
MC_MOVEVELOCITY:

Fig. 5: PLCopen block MC_POWER

Fig. 6: PLCopen block MC_HALT
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Fig. 7: PLCopen block MC_RESET

Fig. 8: PLCopen block MC_MOVEVELOCITY

For more information about the control of the PLCopen blocks, see the documentation from Siemens or the online help in
the TIA Portal.

5.3.5.2.3 Testing the application

Test the correct function of the application in TIA Portal via a user program using PLCopen programming for technology
objects.

For commissioning, you can check the axis functionality via the axis control panel of the technology object (Project tree >
Devices tab > Technology object of the relevant controller > Commissioning).

For diagnostics, you can check status and error bits, the status of the movement as well as the PROFIdrive telegram (Project
tree > Devices tab > Technology object of the relevant controller > Diagnostics).

After testing the application, transfer the configuration (see Transmitting the configuration [} 65]).
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5.3.5.3 TO_PositioningAxis, TO_SynchronousAxis and telegram 3, 5, 102 or 105

With technology objects TO_PositioningAxis and TO_SynchronousAxis, you can implement the control of a position-
controlled axis. TO_SynchonousAxis includes all functions of TO_PositioningAxis, but slave axes can follow the movements
of a master axis. From the perspective of the drive, the parameterization of the technology objects is identical. You can use
both technology objects with standard telegram 3 or 5 or with Siemens telegram 102 or 105.

5.3.5.3.1 Assigning an organization block

For control in application class 4 (synchronous operation), in the next step, assign the MC-Servo organization block to the
telegram submodule for calculating the position controller.

ü You have configured the drive controllers and projected one telegram submodule per axis.

ü You are in the TIA network view.

1. Double-click on a drive controller of your PROFINET network.

ð This switches you to the device view of the drive controller.

2. Select the telegram submodule in the device overview of the drive controller.

ð The inspector window shows the device properties of the submodule.

3. General tab:
Select I/O addresses in the area navigation.

4. Input addresses area > Organization block:
Select MC-Servo.

5. Output addresses area > Organization block:
Select MC-Servo.

ð You have assigned the organization module to the submodule.
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5.3.5.3.2 Adding and configuring measuring inputs

If you want to use the measuring input function to acquire the current actual position of the axis, add the
TO_MeasuringInput technology object to the TO_PositioningAxis or TO_SynchronousAxis technology object.

Adding a measuring input

ü You have added the TO_PositioningAxis or TO_SynchronousAxis technology object to your controller.

1. Project tree > Devices tab:
Open the Measuring input folder of the relevant technology object.

2. Double-click Add new measuring input.

ð The new measuring input is created and placed in the Measuring input folder.

3. Repeat the steps if you want to add a second measuring input.

Configuring a measuring input

ü You have added a measuring input.

1. Project tree > Devices tab:
Open the folder of the measuring input.

2. Open the configuration of the measuring input.

ð This switches you to the corresponding function view.

3. Select Hardware interface in the area navigation.

4. Input measuring input area > Measuring using PROFIdrive telegram (drive or external encoder):
Activate this option.

5. Input measuring input area > Number of the measuring input:
Select the measuring input number.

6. If you have added a further measuring input, repeat the steps for the second measuring input.

Information

In DriveControlSuite, define the sources of the measuring inputs (hardware interface) in parameter M539. M539[0]
corresponds to measuring input 1 of the technology object and M539[1] corresponds to measuring input 2 of the
technology object. For the setting in the DriveControlSuite wizard, select Application PROFIdrive > Additional functions >
Measuring input.
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5.3.5.3.3 Configuring a technology object

Configure the basic settings for your technology object, define the hardware interface of the drive and set other parameters
required for your application. Depending on the telegram used, further settings may then be required:

§ For telegram 102 or 105, the behavior of the monitoring at torque reduction

§ For telegram 5 or 105, the settings for position control in the drive (DSC)

Parameterizing basic parameters

ü You have added the TO_PositioningAxis or TO_SynchronousAxis technology object to your controller.

1. Project tree > Devices tab:
Open the folder of the technology object.

2. Double-click to open the configuration of the technology object.

ð This switches you to the corresponding function view.

3. In the area navigation, select Basic parameters.

4. Set the basic parameters in accordance with your requirements. These basic parameters are independent of the
parameterization in the drive controller.

5. Name:
Enter the name to be used for the axis assignment at the PLCopen blocks.

Parameterizing the hardware interface

Information

Reference speed, maximum speed and reference torque:
Apply the values from the DriveControlSuite, Application PROFIdrive wizard > Additional functions > Drive data.

ü You are in the TIA function view of the technology object.

1. In the area navigation, select Hardware interface > Drive.

2. Drive type:
Select PROFIdrive.

3. Data connection:
Select Drive.

4. Drive:
Select the drive with the telegram submodule already inserted.

5. In the area navigation, select Hardware interface > Encoder.

6. Data connection:
Select Encoder.

7. Encoder:
Select the drive with the telegram submodule already inserted, as this contains the required encoder data.

8. Encoder type:
Select the type of encoder connected to the drive controller:

8.1. Select Incremental for incremental encoders.

8.2. Select Absolute for single-turn absolute encoders.

8.3. Select Cyclic absolute for multi-turn absolute encoders.
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9. In the area navigation, select Hardware interface > Data exchange with the drive > Drive data area.

10. Drive telegram:
Select the telegram that corresponds to the telegram of the inserted submodule.

11. Reference speed:
Enter the reference speed for the set velocity.
This must match the value on the drive controller side.

12. Maximum speed:
Enter the maximum permitted speed.
This must match or be smaller than the value on the drive controller side.

13. Reference torque:
Enter the reference torque.
This must match the value on the drive controller side.

14. Additional data area > Additional telegram:
If you have projected an additional telegram, select the PROFIdrive module with the additional telegram submodule
inserted.

15. In the area navigation, select Hardware interface > Data exchange with encoder.

16. Encoder telegram:
Select the additional telegram that corresponds to the additional telegram of the inserted submodule.

17. Automatically apply values during run time (online):
Activate this option so that the technology object reads the required values from the drive controller.
If automatic readout is not supported by the controller, you must enter the required encoder values manually (see
Required encoder values [} 144]).

18. In the area navigation, select Extended Parameters > Mechanics.
Encoder mounting type:
Select On motor shaft.
Other options are not supported.

Parameterizing extended parameters

ü You are in the TIA function view of the technology object.

1. In the area navigation, select Extended Parameters > Mechanics.

2. Encoder mounting type:
Select On motor shaft. Other options are not supported.

3. In the area navigation, select Extended Parameters > Dynamic default values.

4. Implement the settings necessary for your application.

5. Velocity:
Enter the velocity.
This must match or be smaller than parameter I10 on the drive controller side.

6. Acceleration:
Enter the acceleration.
This must match or be smaller than parameter I11 on the drive controller side.

7. Deceleration:
Enter the deceleration.
This must match or be smaller than parameter I11 on the drive controller side.

8. In the area navigation, select Extended Parameters > Emergency stop.
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9. Implement the settings necessary for your application.

10. Maximum velocity:
Enter the maximum permitted velocity.
This must match or be smaller than parameter I10 on the drive controller side.

11. Emergency deceleration:
Enter the quick stop deceleration.
This must match or be smaller than parameter I17 on the drive controller side.

12. In the area navigation, select Extended Parameters > Limits > Dynamic limits.

13. Implement the settings necessary for your application.

14. Maximum velocity:
Enter the maximum permitted velocity.
This must match or be smaller than parameter I10 on the drive controller side.

15. Maximum acceleration:
Enter the maximum permitted acceleration.
This must match or be smaller than parameter I11 on the drive controller side.

16. Maximum deceleration:
Enter the maximum permitted delay.
This must match or be smaller than parameter I11 on the drive controller side.

Parameterizing the behavior of monitoring during torque reduction (telegram 102 or 105)

For telegram 102 or 105, define the behavior for position-related monitoring (positioning monitoring/following error
monitoring) and effective torque/force limiting.

ü You are in the TIA function view of the technology object.

1. In the area navigation, select Extended Parameters > Limits > Torque limits.

2. Position-related monitoring area:

2.1. To deactivate following error monitoring and positioning monitoring during torque/force limiting, select
Disable position-related monitoring.

2.2. To enable position-related monitoring, select Leave position-related monitoring enabled.

Information

Limits can cause a larger difference to develop between the set position and actual position for position-controlled axes.
This can lead to an unintentional response of the positioning monitoring and following error monitoring.

For the torque reduction, you need PLCopen block MC_TORQUELIMITING, with which you define the limiting value during
programming (see Programming torque reduction [} 56]).
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Parameterizing position control (telegram 5 or 105)

Set the position control in the drive (DSC) for telegram 5 or 105.

ü You are in the TIA function view of the technology object.

1. In the area navigation, select Positioning monitoring > Control loop.

2. Position control area > Gain (Kv factor):
Define the value for the gain.

3. Dynamic Servo Control (DSC) area:
Activate the Position control in the drive (DSC enabled) option (preset for telegram 5 or 105).

ATTENTION!

Material damage due to vibrations!

With DSC, the position control in the drive is executed synchronously with the velocity control. This makes it possible to set
a much larger value for the gain (proportional coefficient).

▪ Define the gain value for your application accordingly.

▪ Start with a smaller value and increase it gradually to avoid vibrations.

▪ Decrease the gain before deactivating DSC.

Information

When torque/force limiting is active, a larger difference can develop between the set and actual positions. The axis
continuously attempts to reduce the lag while the set value remains constant.

▪ Increase the limiting values or deactivate the limit while position control is active. This allows the axis to accelerate
briefly to reduce the lag.

▪ Switch the axis to non-position-controlled operation. As a result, the following error is no longer in effect.

To switch the axis to non-position controlled operation, set PLCopen block MC_MOVEVELOCITY at the PositionControlled
input to FALSE (see Programming the control [} 58]).
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5.3.5.3.4 Programming measuring inputs

The TO_MeasuringInput technology object is controlled using PLCopen blocks MC_MEASURINGINPUT and
MC_ABORTMEASURINGINPUT.

Fig. 9: PLCopen blocks MC_MEASURINGINPUT and MC_ABORTMEASURINGINPUT

The following measuring methods are supported at the Mode input:

Mode Description

0 Measurement of the next rising edge

1 Measurement of the next falling edge

2 Measurement of the next two edges and saving of the measurement results:

§ Rising edge = MeasuredValue 1

§ Falling edge = MeasuredValue 2

Tab. 10: Measuring inputs: supported measuring methods

For more information about the control of the PLCopen blocks, see the documentation from Siemens or the online help in
the TIA Portal.
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5.3.5.3.5 Programming torque reduction

With telegram 102 or 105, you can use PLCopen block MC_TORQUELIMITING to limit the torque at the Limit input in both
directions.

Fig. 10: PLCopen block MC_TORQUELIMITING

The following methods are supported at the Mode input:

Mode Description

0 Torque/force limiting

1 Detecting the fixed stop

Tab. 11: Torque reduction: supported methods

Information

When torque/force limiting is active, a larger difference can develop between the set and actual positions. The axis
continuously attempts to reduce the lag while the set value remains constant.

▪ Increase the limiting values or deactivate the limit while position control is active. This allows the axis to accelerate
briefly to reduce the lag.

▪ Switch the axis to non-position-controlled operation. As a result, the following error is no longer in effect.

To switch the axis to non-position controlled operation, set PLCopen block MC_MOVEVELOCITY at the PositionControlled
input to FALSE (see Programming the control [} 58]).

For more information about the control of the PLCopen blocks, see the documentation from Siemens or the online help in
the TIA Portal.



STÖBER 5 | Commissioning
11

/2
02

5 
| 

ID
 4

43
27

0.
04

57

5.3.5.3.6 Programming Siemens additional telegram 750

With Siemens additional telegram 750, you can implement the following functions using the PLCopen blocks listed:

§ MC_TORQUERANGE for specifying a torque limit with definition of a maximum permissible positive torque (UpperLimit
input) and a maximum permissible negative torque (LowerLimit input)

§ MC_TORQUEADDITIVE for specifying an additive torque (Value input) in order to add an additional torque in the drive

Fig. 11: PLCopen block MC_TORQUERANGE

Fig. 12: PLCopen block MC_TORQUEADDITIVE

For more information about the control of the PLCopen blocks, see the documentation from Siemens or the online help in
the TIA Portal.
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5.3.5.3.7 Programming the control

The TO_PositioningAxis and TO_SynchronousAxis technology objects are controlled using PLCopen blocks
MC_MOVECELOCITY, MC_POWER, MC_HALT, MC_RESET, MC_HOME, MC_MOVERELATIVE, MC_MOVEABSOLUTE and
MC_MOVEJOG:

Fig. 13: PLCopen block MC_MOVEVELOCITY

Information

To switch the axis to non-position-controlled operation when torque/force limiting is active, set PLCopen block
MC_MOVEVELOCITY at the PositionControlled input to FALSE.

Fig. 14: PLCopen block MC_POWER
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Fig. 15: PLCopen block MC_HALT

Fig. 16: PLCopen block MC_RESET

Fig. 17: PLCopen block MC_HOME



5 | Commissioning STÖBER

60

11
/2

02
5 

| 
ID

 4
43

27
0.

04

Fig. 18: PLCopen block MC_MOVERELATIVE

Fig. 19: PLCopen block MC_MOVEABSOLUTE

Fig. 20: PLCopen block MC_MOVEJOG
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For the TO_SynchronousAxis technology object, PLCopen blocks MC_GEARIN and MC_MOVESUPERIMPOSED are also
available:

Fig. 21: PLCopen block MC_GEARIN

Fig. 22: PLCopen block MC_MOVESUPERIMPOSED

For more information about the control of the PLCopen blocks, see the documentation from Siemens or the online help in
the TIA Portal.

5.3.5.3.8 Testing the application

Test the correct function of the application in TIA Portal via a user program using PLCopen programming for technology
objects.

For commissioning, you can check the axis functionality via the axis control panel of the technology object (Project tree >
Devices tab > Technology object of the relevant controller > Commissioning).

For diagnostics, you can check status and error bits, the status of the movement as well as the PROFIdrive telegram (Project
tree > Devices tab > Technology object of the relevant controller > Diagnostics).

After testing the application, transfer the configuration (see Transmitting the configuration [} 65]).
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5.3.5.4 TO_BasicPos and Siemens telegram 111

With the technology object TO_BasicPos, you can implement the control of a position-controlled axis. You can use this
technology object with Siemens telegram 111.

5.3.5.4.1 Configuring a technology object

Define the hardware interface of the drive.

ü You have added the TO_BasicPos technology object to your controller.

1. Project tree > Devices tab:
Open the folder of the technology object.

2. Double-click to open the configuration of the technology object.

ð This switches you to the corresponding function view.

3. HIn the area navigation, select Hardware interface > Drive.

4. Drive:
Select the drive with the telegram submodule already inserted.

5.3.5.4.2 Programming the control

The TO_BasicPos technology object is controlled via its function block:

Fig. 23: TO_BasicPos block

For more information about the control of the block, see the documentation from Siemens or the online help in TIA Portal.

5.3.5.4.3 Testing the application

Test the correct function of the application in TIA Portal via a corresponding user program or via the interface of the block
TO_BasicPos.

After testing the application, transfer the configuration (see Transmitting the configuration [} 65]).
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5.3.6 Control via function blocks
The following chapters describe how to configure the control using function blocks. Follow the instructions for the function
block with which you want to operate the corresponding axis.

5.3.6.1 FB SINA_SPEED and standard telegram 1

With the function block SINA_SPEED, you can implement the control of a velocity-controlled axis. You can use this function
block with standard telegram 1.

Programming the control

Fig. 24: Function block SINA_SPEED

For communication with the drive controller, you need the hardware identifier of the telegram submodule on the controller
side. The hardware identifier, 267 in this example, is displayed in the Inspector window > System constants tab if you select
the telegram in the device overview of the workspace.

Store the address for the inputs HWIDSTW (transmitting side from controller view) and HWIDZSW (receiving side from
controller view).

Input Data type Required value

HWIDSTW HW_IO Hardware identifier of the telegram submodule

HWIDZSW HW_IO Hardware identifier of the telegram submodule

Tab. 12: Function block SINA_SPEED: Required values

For further information about the control of the function block, see the DriveLib documentation from Siemens.

Testing the application

Test the correct function of the application in the TIA Portal via a corresponding user program.

After testing the application, transfer the configuration (see Transmitting the configuration [} 65]).
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5.3.6.2 FB SINA_POS and telegram 111

With the function block SINA_POS, you can implement the control of a position-controlled axis. You can use this function
block with Siemens telegram 111.

Programming the control

Fig. 25: Function block SINA_POS

For communication with the drive controller, you need the hardware identifier of the telegram submodule on the controller
side. The hardware identifier, 267 in this example, is displayed in the Inspector window > System constants tab if you select
the telegram in the device overview of the workspace.

Store the address for the inputs HWIDSTW (transmitting side from controller view) and HWIDZSW (receiving side from
controller view).

Input Data type Required value

HWIDSTW HW_IO Hardware identifier of the telegram submodule

HWIDZSW HW_IO Hardware identifier of the telegram submodule

Tab. 13: Function block SINA_POS: Required values

For further information about the control of the function block, see the DriveLib documentation from Siemens.

Testing the application

Test the correct function of the application in TIA Portal via a corresponding user program or via the interface of the
function block SINA_POS.

After testing the application, transfer the configuration (see Transmitting the configuration [} 65]).
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5.3.7 Transmitting the configuration
Transmit the configuration of your TIA project from your PC to your controller.

ü You have fully mapped and parameterized your PROFINET network in the TIA project.

1. Project navigation > Devices tab:
Select the folder of the controller in question.

2. Select Online > Advanced download to device in the menu bar.

ð The Advanced download window opens.

3. Select target device area:
Select Show all compatible nodes and click on Start search.

ð All controllers are listed that were found in the subnet.

4. Select the controller where you would like to transfer the configuration and click on Download.

ð The Software synchronization before downloading to a device window opens.

5. Click on Continue without synchronizing.

ð The Preview download window opens.

6. Click on Download.

ð The configuration is transmitted to the selected controller and the Results of the download process window
opens.

7. Click on Finish.

ð The download process is complete; the configuration was transmitted successfully to the controller.

Information

If there is an online connection, you can identify which controller you have currently selected using Flash LED if multiple
controllers are located in the same subnet.

Information

In DriveControlSuite, parameter A271 provides information about the state of the drive controller in the PROFINET
network. If the application selected in DriveControlSuite does not match the inserted module in TIA Portal, the status
6: Configuration Application / PROFINE does not fit is output there.

▪ In this case, make sure that the device control and the PROFIdrive application are projected in DriveControlSuite and
that a PROFIdrive module has been inserted in TIA Portal.

Information

Parameter A272 in DriveControlSuite provides information about the submodules projected in TIA Portal (display format:
XXX YYY ZZZ; XXX = submodule ID (telegram no.), YYY = TxPZD data length in bytes, ZZZ = RxPZD data length in bytes).
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5.3.8 Testing communication
Check the communication between the controller and drive controllers of your PROFINET network using the diagnostics
buffer of the controller.

ü You have transferred the configuration to the controller.

1. Project tree > Devices tab:
Open the folder of the relevant controller.

2. Double-click Online & diagnostics.

ð This switches you to the respective device view.

3. Select Online access in the area navigation.

4. Online access area:
Click on Go online.

ð An online connection to the selected controller is being established.

5. In the area navigation, select Diagnostics > Diagnostics buffer.

6. Results area:
Check the events in the diagnostics buffer for possible errors and correct their causes if necessary.

ð The connection between the controller and drive controller is projected and a data exchange between the nodes in
the PROFINET network is possible.

Information

If there is an online connection, you can identify which controller you have currently selected using Flash LED if multiple
controllers are located in the same subnet.
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6 More on PROFIdrive?
The following chapters summarize the important terms and relationships concerning the application PROFIdrive.

6.1 PROFIdrive – Concept
Depending on the selected control, you can implement drive- or controller-based applications using the PROFIdrive
application. The drive-based applications provide full motion calculation and execution in the drive. Here, the set values for
position and velocity are converted into movements accurately and precisely. Referencing and jogging are performed, like
all movements, with jerk limitation during commissioning. In controller-based applications with cyclic set value specification
by the controller, the drive controllers can also perform motion tasks independently, for example referencing and the jog
function during commissioning. The drive controllers are either networked via PROFINET or receive signals and set values
via digital hardware inputs.

6.1.1 Control
The application is based on the internationally standardized drive profile PROFIdrive for electric drives (version 4.2)
according to IEC 61800-7-303. Accordingly, the drive controller is controlled using the PROFIdrive-compliant control and
status words.

6.1.2 Application classes and telegrams
Depending on the type and scope of the application processes, there are different application classes for the PROFIdrive
application. These can be reached via various telegrams. In production mode, these 3 application classes are available with
the respective telegrams:

Application class 1 (AC1)

§ Set velocity specification by a controller

§ Standard telegram 1, 2 or 3

§ Siemens telegram 102 with torque reduction

Application class 3 (AC3)

§ Set position specification by a controller

§ Siemens telegram 111

Application class 4 (AC4)

§ Synchronized, cyclic set velocity specification by a controller

§ Telegram-dependent with torque reduction and/or Dynamic Servo Control (DSC)

§ Standard telegram 3 or 5

§ Siemens telegram 102 or 105

Additional telegrams

Siemens additional telegram 750 provides additional process data for torque feedforward control via additive torque and
for different torque limits in the positive and negative direction. The combination of standard telegram 3 or 5 and
additional telegram 750, for example, offers a greater range of functions compared to Siemens telegram 102 or 105. The
additional telegram can be combined with all telegrams and used in all application classes.

The additional telegram 900 is a freely assignable telegram. You can combine it with all telegrams and use it in all
application classes.



6 | More on PROFIdrive? STÖBER

68

11
/2

02
5 

| 
ID

 4
43

27
0.

04

Further functions

You can use the measuring input function for recording the actual position of the axis with standard telegram 3 or 5 or with
Siemens telegram 102 or 105.

For commissioning, emergency operation and maintenance or repair work, you can also use jog mode (manual operation)
to move the drive independently of the controller.

For more information on application classes and telegrams, see Application classes and telegrams in detail [} 69].

6.1.3 Control panels
The control panels are special wizards in DriveControlSuite, which you can use to take control of the axis. With the help of
the control panels, you can manually release and move an axis even if the drive controller has no operating unit or is
difficult to access.

Using control panels, you can check the connection wiring, the project configuration of your physical axis model or the
parameterization of your application before you start commissioning the controller or switch to normal operation.

The following control panels are available:

§ Jog control panel is used to check the projected axis model in jog mode.

§ Control panel motion provides you with a standard set of motion commands based on PLCopen. Via the control panel,
independent of the application and fieldbus interface, you can parameterize a motion profile directly for the motion
core of the axis in order to check the basic functions of the drive controller.

Because control panels override normal operation, they can be activated only with a deactivated enable signal and should
be operated by experienced users only.

6.1.4 Data sources
The signals for controlling the drive controller, i.e. control signals for the start of motion, motion limits or set value
specifications, can be obtained from various external sources.

A fieldbus is usually acts as the signal source, but digital hardware inputs, or even mixed operation of the above-listed
sources, can also be used to control the drive controller.

Values that are obtained from external data sources are usually adapted to the stored reference values automatically, i.e.
calibrated and calculated with scaling.
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6.2 Application classes and telegrams in detail
Depending on the type and scope of the application processes, there are different application classes for the PROFIdrive
application, which can be reached via different telegrams.

Selecting a telegram determines the process data on the drive controller side that is to be transmitted. From the drive
controller's point of view, the received process data represents the receive process data (RxPZD) and the process data to be
transmitted represents the transmit process data (TxPZD). This data consists of the following elements:

§ Receive PZD: Control words (STW) or set values

§ Transmit PZD: Status words (ZSW) or actual values

The time-critical process data is exchanged cyclically.

The mapping of the process data via the telegram is specified by the controller to the drive controller in parameter M513
and displayed in parameter M512.

Standard telegrams

The standard telegrams correspond to the standardized PROFIdrive profile.

The following standard telegrams can be selected:

Standard telegram Application class Description

1 AC1 Set velocity 16 bit

2 AC1 Set velocity 32 bit

3 AC1, AC4 Set velocity 32 bit with 1 position encoder

5 AC4 Set velocity 32 bit with 1 position encoder and Dynamic Servo Control

Tab. 14: Standard telegrams of the PROFIdrive application

Manufacturer-specific telegrams

There are the following manufacturer-specific telegrams:

Siemens telegram Application class Description

102 AC1, AC4 Set velocity 32 bit with 1 position encoder and torque reduction

105 AC4 Set velocity 32 bit with 1 position encoder, torque reduction and Dynamic
Servo Control

111 AC3 Positioning (single positioner)

Tab. 15: Manufacturer-specific telegrams of the application PROFIdrive

Manufacturer-specific additional telegrams

The following manufacturer-specific additional telegrams are available:

Additional telegram Application class Description

750 All Siemens additional telegram; additional process data for torque feedforward
control via additive torque and for different torque limits in positive and
negative direction

900 All Additional telegram for free assignment with further process data

Tab. 16: Manufacturer-specific additional telegrams of the PROFIdrive application
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6.2.1 Standard mapping of PROFINET and PROFIdrive
The following table shows the standard mapping for the receive and transmit process data in the PROFIdrive application.

Information

Parameter A272 in DriveControlSuite provides information about the submodules projected in TIA Portal (display format: XXX YYY ZZZ; XXX = submodule ID (telegram no.), YYY = TxPZD data
length in bytes, ZZZ = RxPZD data length in bytes).

Telegram AC Receive PZD Length
(byte)

Transmit PZD Length
(byte)

Display in
A272

1 1 M515 Control word 1 (STW1),
M520 Speed setpoint A (NSOLL_A)

2,
2

M516 Status word 1 (ZSW1),
M522Speed actual value A (NIST_A)

2,
2

1004004

2 1 M515 Control word 1 (STW1),
M521 Speed setpoint B (NSOLL_B),
M517 Control word 2 (STW2)

2,
4,
2

M516 Status word 1 (ZSW1),
M523 Speed actual value B (NIST_B),
M518 Status word 2 (ZSW2)

2,
4,
2

2008008

3 1,
4

M515 Control word 1 (STW1),
M521 Speed setpoint B (NSOLL_B),
M517 Control word 2 (STW2),
M526 Sensor 1 control word (G1_STW)

2,
4,
2,
2

M516 Status word 1 (ZSW1),
M523 Speed actual value B (NIST_B),
M518 Status word 2 (ZSW2),
M527 Sensor 1 status word (G1_ZSW),
M528 Sensor 1 position actual value 1 (G1_XIST1),
M529 Sensor 1 position actual value 2 (G1_XIST2)

2,
4,
2,
2,
4,
4

3018010

5 4 M515 Control word 1 (STW1),
M521 Speed setpoint B (NSOLL_B),
M517 Control word 2 (STW2),
M526 Sensor 1 control word (G1_STW),
M559 Position deviation (XERR),
M560 Position controller proportional coefficient (KPC)

2,
4,
2,
2,
4,
4

M516 Status word 1 (ZSW1),
M523 Speed actual value B (NIST_B),
M518 Status word 2 (ZSW2),
M527 Sensor 1 status word (G1_ZSW),
M528 Sensor 1 position actual value 1 (G1_XIST1),
M529 Sensor 1 position actual value 2 (G1_XIST2)

2,
4,
2,
2,
4,
4

5018018
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Telegram AC Receive PZD Length
(byte)

Transmit PZD Length
(byte)

Display in
A272

102 1,
4

M515 Control word 1 (STW1),
M521 Speed setpoint B (NSOLL_B),
M517 Control word 2 (STW2),
M558 Torque reduction (MOMRED)
M526 Sensor 1 control word (G1_STW)

2,
4,
2,
2,
2

M516 Status word 1 (ZSW1),
M523 Speed actual value B (NIST_B),
M518 Status word 2 (ZSW2),
M557 Notification word (MELDW),
M527 Sensor 1 status word (G1_ZSW),
M528 Sensor 1 position actual value 1 (G1_XIST1),
M529 Sensor 1 position actual value 2 (G1_XIST2)

2,
4,
2,
2,
2,
4,
4

102020012

105 4 M515 Control word 1 (STW1),
M521 Speed setpoint B (NSOLL_B),
M517 Control word 2 (STW2),
M558 Torque reduction (MOMRED)
M526 Sensor 1 control word (G1_STW),
M559 Position deviation (XERR),
M560 Position controller proportional coefficient (KPC)

2,
4,
2,
2,
2,
4,
4

M516 Status word 1 (ZSW1),
M523 Speed actual value B (NIST_B),
M518 Status word 2 (ZSW2),
M557 Notification word (MELDW),
M527 Sensor 1 status word (G1_ZSW),
M528 Sensor 1 position actual value 1 (G1_XIST1),
M529 Sensor 1 position actual value 2 (G1_XIST2)

2,
4,
2,
2,
2,
4,
4

105020020

111 3 M515 Control word 1 (STW1),
M550 Positioning control word 1 (POS_STW1),
M551 Positioning control word 2 (POS_STW2),
M517 Control word 2 (STW2),
M554 Speed override (Override),
M530 MDI target position (MDI_TARPOS),
M531 MDI velocity (MDI_VELOCITY),
M532 MDI acceleration (MDI_ACC),
M533 MDI deceleration (MDI_DEC)

2,
2,
2,
2,
2,
4,
4,
2,
2

M516 Status word 1 (ZSW1),
M552 Positioning status word 1 (POS_ZSW1),
M553 Positioning status word 2 (POS_ZSW2),
M518 Status word 2 (ZSW2),
M557 Notification word (MELDW),
M535 Position actual value A (XIST_A),
M523 Speed actual value B (NIST_B),
M555 Fault number (FAULT_Code),
M556 Alarm number (WARN_Code)

2,
2,
2,
2,
2,
4,
4,
2,
2

111022022

750 All M562 Couple supplémentaire (M_ADD1),
M563 Maximum positive torque (M_LIMIT_POS),
M564 Maximum negative torque (M_LIMIT_NEG)

2,
2,
2

M561 Actual torque (M_ACT) 2 750002006

900 All Free assignment 12 (total) Free assignment 12 (total) 900012012

Tab. 17: Receive and transmit process data (standard mapping)
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6.2.2 Application class 1 (standard drive)
Application class 1 (AC1) is intended for velocity-controlled axes and includes velocity control with an integrated profile
generator. The set values for the velocity are specified by the controller and read in the drive controller according to the
cycle time. The complete velocity control takes place in the drive controller.

Application Class 1

Automation

Technology

Drive Drive Drive

Open Loop Speed Control/
Closed Loop Speed Control

Open Loop Speed Control/
Closed Loop Speed Control

Open Loop Speed Control/
Closed Loop Speed Control

Control Word + Speed
Setpoint + ...

Status Word + 
Speed Act. Val. + ...

M M MEncoder
(optional)

Encoder
(optional)

Encoder
(optional)

Fig. 26: PROFIdrive: Application class 1 (source: PROFIdrive profile)

To control application class 1, the three standard telegrams 1, 2 and 3 as well as Siemens telegram 102 are defined for
PROFIdrive and implemented in the application.
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6.2.2.1 Standard telegram 1 in AC1

The standard telegram 1 (set velocity 16 bit) can be used in application class 1.

Structure

The mapping of the process data is specified by the controller (M512, M513).

The following tables show the structure of the telegram.

PZD no. Data type Name Parameter

1 WORD Control word 1 (STW1) M515

2 INT16 Speed setpoint A (NSOLL_A) M520

Tab. 18: Standard telegram 1: RxPZD

PZD no. Data type Name Parameter

1 WORD Status word 1 (ZSW1) M516

2 INT16 Speed actual value A (NIST_A) M522

Tab. 19: Standard telegram 1: TxPZD

Input and output signals

n
%1

00

%
n

Limit

M571
214

M571

Unfreeze ramp function generator

Enable ramp function generator

Motion
core

I10

214

M520
NSOLL_A

M515 STW1, Bit 5

M515 STW1, Bit 4

M515
STW1, Bit 6

M522
NIST_A

Fig. 27: Standard telegram 1 in AC1: Input and output signals
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Control and status information

The telegram is specified by the controller in parameter M513. The active telegram is output in parameter M512. If
standard telegram 1 is active, the information 1: Standard telegram 1 is displayed there.

The following telegram-specific bits are assigned in control word 1 M515:

Bit Designation Comment

4 Enable ramp generator Activate calculation of the motion profile:
0 = velocity specification = 0; 
1 = velocity specification by Speed setpoint (M520)

5 Unfreeze ramp generator Unfreeze motion profile calculation:
0 = velocity specification = last velocity specification before freeze; 
1 = velocity specification by Speed setpoint (M520)

6 Enable setpoint Deactivate set velocity:
0 = velocity specification = 0; 
1 = velocity specification by Speed setpoint (M520)

12 Open brake Release brakes (prerequisite: F06 = 2: Parameter):

§ F92[0] = 0: Internal (automatic): Release override
0 = brake control is automatic depending on device state and motion
core;
1 = brakes release

§ F92[0] = 1: External (plc): Brakes are controlled externally by a
controller
0 = brakes engage; 1 = brakes release

Tab. 20: Standard telegram 1: telegram-specific bit in control word 1

The following telegram-specific bits are assigned in status word 1 M516:

Bit Designation Comment

8 Error within tolerance range Actual velocity within the permitted tolerance around the set velocity
(source: M598):
0 = inactive; 1 = active

10 Target velocity reached Target velocity reached (source: M596):
0 = inactive; 1 = active

11 Torque/force limit not reached Torque/force limit not reached (source: E180)

12 Brake control status

13 No overtemperature of the motor No overtemperature of the motor (source: E82, event
41: Temp.MotorTMP):
0 = inactive; 1 = active

14 Positive actual velocity Positive actual velocity (source: I88 > 0):
0 = inactive; 1 = active

15 No overtemperature of the drive
controller

No overtemperature of the drive controller (source: E82, event
38: Temperature drive controller sensor):
0 = inactive; 1 = active

Tab. 21: Standard telegram 1: telegram-specific bit in status word 1

Information

Parameter M571 Velocity reference value provides the reference value for the set velocity and actual velocity and ensures
the function of the application.



STÖBER 6 | More on PROFIdrive?
11

/2
02

5 
| 

ID
 4

43
27

0.
04

75

6.2.2.2 Standard telegram 2 in AC1

The standard telegram 2 (set velocity 32 bit) can be used in application class 1.

Structure

The mapping of the process data is specified by the controller (M512, M513).

The following tables show the structure of the telegram.

PZD no. Data type Name Parameter

1 WORD Control word 1 (STW1) M515

2 + 3 INT32 Speed setpoint B (NSOLL_B) M521

4 WORD Control word 2 (STW2) M517

Tab. 22: Standard telegram 2: RxPZD

PZD no. Data type Name Parameter

1 WORD Status word 1 (ZSW1) M516

2 + 3 INT32 Speed actual value B (NIST_B) M523

4 WORD Status word 2 (ZSW2) M518

Tab. 23: Standard telegram 2: TxPZD

Input and output signals
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Fig. 28: Standard telegram 2 in AC1: Input and output signals
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Control and status information

The telegram is specified by the controller in parameter M513. The active telegram is output in parameter M512. If
standard telegram 2 is active, the information 2: Standard telegram 2 is displayed there.

The following telegram-specific bits are assigned in control word 1 M515:

Bit Designation Comment

4 Enable ramp generator Activate calculation of the motion profile:
0 = velocity specification = 0; 
1 = velocity specification by Speed setpoint (M521)

5 Unfreeze ramp generator Unfreeze motion profile calculation:
0 = velocity specification = last velocity specification before freeze; 
1 = velocity specification by Speed setpoint (M521)

6 Enable setpoint Deactivate set velocity:
0 = velocity specification = 0; 
1 = velocity specification by Speed setpoint (M521)

12 Open brake Release brakes (prerequisite: F06 = 2: Parameter):

§ F92[0] = 0: Internal (automatic): Release override
0 = brake control is automatic depending on device state and motion
core;
1 = brakes release

§ F92[0] = 1: External (plc): Brakes are controlled externally by a
controller
0 = brakes engage; 1 = brakes release

Tab. 24: Standard telegram 2: telegram-specific bit in control word 1

The following telegram-specific bits are assigned in status word 1 M516:

Bit Designation Comment

8 Error within tolerance range Actual velocity within the permitted tolerance around the set velocity
(source: M598):
0 = inactive; 1 = active

10 Target velocity reached Target velocity reached (source: M596):
0 = inactive; 1 = active

11 Torque/force limit not reached Torque/force limit not reached (source: E180)

12 Brake control status

13 No overtemperature of the motor No overtemperature of the motor (source: E82, event
41: Temp.MotorTMP):
0 = inactive; 1 = active

14 Positive actual velocity Positive actual velocity (source: I88 > 0):
0 = inactive; 1 = active

15 No overtemperature of the drive
controller

No overtemperature of the drive controller (source: E82, event
38: Temperature drive controller sensor):
0 = inactive; 1 = active

Tab. 25: Standard telegram 2: telegram-specific bit in status word 1

Information

Parameter M571 Velocity reference value provides the reference value for the set velocity and actual velocity and ensures
the function of the application.
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6.2.2.3 Standard telegram 3 in AC1

The standard telegram 3 (set velocity 32 bit with 1 position encoder) can be used in application class 1 or 4.

Structure

The mapping of the process data is specified by the controller (M512, M513).

The following tables show the structure of the telegram.

PZD no. Data type Name Parameter

1 WORD Control word 1 (STW1) M515

2 + 3 INT32 Speed setpoint B (NSOLL_B) M521

4 WORD Control word 2 (STW2) M517

5 WORD Sensor 1 control word (G1_STW) M526

Tab. 26: Standard telegram 3: RxPZD

PZD no. Data type Name Parameter

1 WORD Status word 1 (ZSW1) M516

2 + 3 INT32 Speed actual value B (NIST_B) M523

4 WORD Status word 2 (ZSW2) M518

5 WORD Sensor 1 status word (G1_ZSW) M527

6 +7 INT32 Sensor 1 position actual value 1 (G1_XIST1) M528

8 + 9 INT32 Sensor 1 position actual value 2 (G1_XIST2) M529

Tab. 27: Standard telegram 3: TxPZD

Input and output signals
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Fig. 29: Standard telegram 3 in AC1: Input and output signals
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Control and status information

The telegram is specified by the controller in parameter M513. The active telegram is output in parameter M512. If
standard telegram 3 is active, the information 3: Standard telegram 3 is displayed there.

The following telegram-specific bits are assigned in control word 1 M515:

Bit Designation Comment

4 Enable ramp generator Activate calculation of the motion profile:
0 = velocity specification = 0; 
1 = velocity specification by Speed setpoint (M521)

5 Unfreeze ramp generator Unfreeze motion profile calculation:
0 = velocity specification = last velocity specification before freeze; 
1 = velocity specification by Speed setpoint (M521)

6 Enable setpoint Deactivate set velocity:
0 = velocity specification = 0; 
1 = velocity specification by Speed setpoint (M521)

12 Open brake Release brakes (prerequisite: F06 = 2: Parameter):

§ F92[0] = 0: Internal (automatic): Release override
0 = brake control is automatic depending on device state and motion
core;
1 = brakes release

§ F92[0] = 1: External (plc): Brakes are controlled externally by a
controller
0 = brakes engage; 1 = brakes release

Tab. 28: Standard telegram 3: telegram-specific bit in control word 1

The following telegram-specific bits are assigned in status word 1 M516:

Bit Designation Comment

8 Error within tolerance range Actual velocity within the permitted tolerance around the set velocity
(source: M598):
0 = inactive; 1 = active

10 Target velocity reached Target velocity reached (source: M596):
0 = inactive; 1 = active

11 Torque/force limit not reached Torque/force limit not reached (source: E180)

12 Brake control status

13 No overtemperature of the motor No overtemperature of the motor (source: E82, event
41: Temp.MotorTMP):
0 = inactive; 1 = active

14 Positive actual velocity Positive actual velocity (source: I88 > 0):
0 = inactive; 1 = active

15 No overtemperature of the drive
controller

No overtemperature of the drive controller (source: E82, event
38: Temperature drive controller sensor):
0 = inactive; 1 = active

Tab. 29: Standard telegram 3: telegram-specific bit in status word 1

Information

Parameter M571 Velocity reference value provides the reference value for the set velocity and actual velocity and ensures
the function of the application.
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6.2.2.4 Siemens telegram 102 in AC1

The Siemens telegram 102 (set velocity 32 bit with 1 position encoder and torque reduction) can be used in application
class 1 or 4.

Structure

The mapping of the process data is specified by the controller (M512, M513).

The following tables show the structure of the telegram.

PZD no. Data type Name Parameter

1 WORD Control word 1 (STW1) M515

2 + 3 INT32 Speed setpoint B (NSOLL_B) M521

4 WORD Control word 2 (STW2) M517

5 WORD Torque reduction (MOMRED) M558

6 WORD Sensor 1 control word (G1_STW) M526

Tab. 30: Siemens telegram 102: RxPZD

PZD no. Data type Name Parameter

1 WORD Status word 1 (ZSW1) M516

2 + 3 INT32 Speed actual value B (NIST_B) M523

4 WORD Status word 2 (ZSW2) M518

5 INT16 Notification word (MELDW) M557

6 WORD Sensor 1 status word (G1_ZSW) M527

7 + 8 INT32 Sensor 1 position actual value 1 (G1_XIST1) M528

9 + 10 INT32 Sensor 1 position actual value 2 (G1_XIST2) M529

Tab. 31: Siemens telegram 102: TxPZD

Input and output signals
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Fig. 30: Siemens telegram 102 in AC1: Input and output signals
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Control and status information

The telegram is specified by the controller in parameter M513. The active telegram is output in parameter M512. If Siemens
telegram 102 is active, there is the information 102: Telegram 102.

The following telegram-specific bits are assigned in control word 1 M515:

Bit Designation Comment

4 Enable ramp generator Activate calculation of the motion profile:
0 = velocity specification = 0; 
1 = velocity specification by Speed setpoint (M521)

5 Unfreeze ramp generator Unfreeze motion profile calculation:
0 = velocity specification = last velocity specification before freeze; 
1 = velocity specification by Speed setpoint (M521)

6 Enable setpoint Deactivate set velocity:
0 = velocity specification = 0; 
1 = velocity specification by Speed setpoint (M521)

12 Open brake Release brakes (prerequisite: F06 = 2: Parameter):

§ F92[0] = 0: Internal (automatic): Release override
0 = brake control is automatic depending on device state and motion core;
1 = brakes release

§ F92[0] = 1: External (plc): Brakes are controlled externally by a controller
0 = brakes engage; 1 = brakes release

Tab. 32: Standard telegram 102: telegram-specific bit in control word 1

The following telegram-specific bits are assigned in status word 1 M516:

Bit Designation Comment

8 Error within tolerance range Actual velocity within the permitted tolerance around the set velocity (source:
M598):
0 = inactive; 1 = active

10 Target velocity reached Target velocity reached (source: M596):
0 = inactive; 1 = active

13 – 15 Reserved

Tab. 33: Standard telegram 102: telegram-specific bit in status word 1

The following telegram-specific bits are assigned in status word 2 M518:

Bit Designation Comment

5 CmdActRelBrk, release brake active

Tab. 34: Standard telegram 102: telegram-specific bit in status word 2

Information

Parameter M571 Velocity reference value provides the reference value for the set velocity and actual velocity and ensures
the function of the application.



STÖBER 6 | More on PROFIdrive?
11

/2
02

5 
| 

ID
 4

43
27

0.
04

81

6.2.2.5 Presets in AC1

For application class 1 with standard telegram 1, 2 or 3, the following presets are implemented in DriveControlSuite:

Parameter Default value

K08 Selected operating mode 2: Velocity, torque/force

D01 Command 1: MC_MoveSpeed

D30 Source main reference value 1: Parameter G462

G461 Source external velocity 4: Parameter G460

D15 Control byte fixed acceleration value 15: Fixed acceleration value 15

D17 Control byte fixed deceleration value 15: Fixed deceleration value 15

D19 Control byte fixed jerk value 15: Fixed deceleration value 15

Tab. 35: Presets in AC1: Source digital signals (application)

The presets of the parameters D15, D17 and D19 cause the maximum values from the axis model (I11, I16) to be used for
the profile definition for acceleration, deceleration and jerk.
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6.2.3 Application class 3 (positioning mode)
Application class 3 (AC3) is intended for position-controlled axes. In application class 3, only the higher-level technological
processes run on the controller. Interpolation, position control and velocity control are implemented directly in the drive.
The set value can be specified either in MDI mode (Command operating mode) or in Program mode (Motion block
operating mode).

Application Class 3

Automation

Technology

Drive Drive

Interpolation
Position Control

Interpolation
Position Control

Positioning Ctrl. Word + ... Positioning Status Word + ...

M MEncoder Encoder

Closed Loop Speed Ctrl. Closed Loop Speed Ctrl.

Drive ResponseDrive Request

Fig. 31: PROFIdrive: Application class 3 (source: PROFIdrive profile)

To control application class 3, Siemens telegram 111 is defined for PROFIdrive and implemented in the application.
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6.2.3.1 Siemens telegram 111 in AC3

Siemens telegram 111 (single positioner) can be used in application class 3.

Structure

With the exception of the user-defined user area, the mapping of the process data is specified by the controller (M512,
M513).

The following tables show the structure of the telegram.

PZD no. Data type Name Parameter

1 WORD Control word 1 (STW1) M515

2 WORD Positioning control word 1 (POS_STW1) M550

3 WORD Positioning control word 2 (POS_STW2) M551

4 WORD Control word 2 (STW2) M517

5 INT16 Speed override (Override) M554

6 + 7 INT32 MDI target position (MDI_TARPOS) M530

8 + 9 INT32 MDI velocity (MDI_VELOCITY) M531

10 INT16 MDI acceleration (MDI_ACC) M532

11 INT16 MDI deceleration (MDI_DEC) M533

12 WORD/INT16 User —

Tab. 36: Siemens telegram 111: RxPZD

PZD no. Data type Name Parameter

1 WORD Status word 1 (ZSW1) M516

2 WORD Positioning status word 1 (POS_ZSW1) M552

3 WORD Positioning status word 2 (POS_ZSW2) M553

4 WORD Status word 2 (ZSW2) M518

5 INT16 Notification word (MELDW) M557

6 + 7 INT32 Position actual value A (XIST_A) M535

8 + 9 INT32 Speed actual value B (NIST_B) M523

10 INT16 Fault number (FAULT_Code) M555

11 INT16 Alarm number (WARN_Code) M556

12 WORD/INT16 User Constant value 0

Tab. 37: Siemens telegram 111: TxPZD
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Input and output signals
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Fig. 32: Siemens telegram 111 in AC3: Input and output signals

Control and status information

The telegram is specified by the controller in parameter M513. The active telegram is output in parameter M512. If Siemens
telegram 111 is active, there is the information 111: Telegram 111.

The following telegram-specific bits are assigned in control word 1 M515:

Bit Designation Comment

4 Do not reject traversing task Program submode, Do not reject motion block:
0 = cancel active motion block with quick stop; 
1 = active motion block is not canceled or a new motion block can be started

5 No intermediate stop Program submode, No intermediate stop of motion block:
0 = inactive; 1 = active; 0 → 1 = interrupt active motion block by stop; 
1 → 0 = continue interrupted motion block (MC_Halt; set deceleration: I11; set
jerk: I16; prerequisite: J06 = J06); 0 → 1 = continue canceled motion block
(Continue; prerequisite: J917 = 2: Parameter)

6 Activate traversing Start movement (prerequisite: M515, bit 4 = 1, I100 = 2: Parameter):
0, 1 = inactive; 0 → 1 = active

11 Start homing procedure Start referencing, referencing type I30

Tab. 38: Standard telegram 111: telegram-specific bit in control word 1
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The following telegram-specific bits are assigned in status word 1 M516:

Bit Designation Comment

8 No follow error NoFlwErr, lag within tolerance (source: M598):
0 = inactive; 1 = active

10 Target position reached TargPos, target position reached (source: M596):
0 = inactive; 1 = active

11 Home position set RefPSet, in reference (source: M595):
0 = inactive; 1 = active

12 Traversing task acknowledge TrvTskAck, Execute signal is active and motion command is not finished
(source: M594):
0 = inactive; 1 = active

13 Standstill StndStill, standstill (source: I199):
0 = inactive; 1 = active

14 Accelerate Accel, accelerated (source: I184):
0 = inactive; 1 = active

15 Decelerate Decel, delayed (source: I185):
0 = inactive; 1 = active

Tab. 39: Standard telegram 111: Application-specific bit in status word 1

The following telegram-specific bits are assigned in status word 2 M518:

Bit Designation Comment

5 CmdActRelBrk, release brake active

Tab. 40: Standard telegram 111: telegram-specific bit in status word 2

6.2.3.2 Operating modes in AC3

The set value in application class 3 with Siemens telegram 111 can be specified either in Program mode or in MDI mode.

The mode is specified by the controller in positioning control word 1 (POS_STW1) in parameter M550. If bit 15 is set to the
value 0, the motion block operating mode is activated at the application level. Bit 15 must be set to the value 1 for
command operating mode.

Bit Designation Comment

15 MDI start MdiStart, Specification operating mode:
0 = Program mode (motion block operating mode); 
1 = MDI mode (command operating mode)

Tab. 41: Specification operating mode: Bit 15 in positioning control word 1

The active operating mode is output in the parameter K09.

For more information on parameterizing the motion block and command operating modes in drive-based applications using
DriveControlSuite, refer to the documentation for the Drive Based application (see Further information [} 148]).

6.2.3.3 Presets in AC3

For application class 3 with Siemens telegram 111, the following presets for the Program mode are implemented in
DriveControlSuite:

Parameter Default value

J03 Source motion block selection 1: Parameter J02

Tab. 42: Presets in AC3: Source selection motion block
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6.2.3.4 Application class AC3 according to PROFIdrive – Commands

In application class 3 with Siemens telegram 111, special motion commands are used that are based on the PLCopen
standard and supplemented by two manufacturer-specific motion commands (MC_DoNothing and MC_MoveSpeed). Any
motion command – except MC_Stop – can be overwritten during execution.

In order to execute a command, the drive controller must not be in the Switch on disabled device state.

Settings 
(Program mode)

Command Feature Control type Necessary motion
variables

M550, bit 15 = 0 + 
J11 (selection of the
command)

0: MC_DoNothing — — —

1: MC_MoveAbsolute Axis moves to an
absolute set position
(referencing necessary)

Position § Position

§ Velocity, override

§ Acceleration

§ Deceleration

§ Jerk

2: MC_MoveRelative Axis moves a relative
distance; set position is
relative to the actual
position at the start of
the command

Position § Position

§ Velocity, override

§ Acceleration

§ Deceleration

§ Jerk

3: MC_MoveAdditive Axis moves a relative
distance; set position is
relative to the set
position of the previous
motion command

Position § Position

§ Velocity, override

§ Acceleration

§ Deceleration

§ Jerk

4: MC_MoveVelocity Axis moves without end
with set velocity (with
position control)

Position § Velocity, override

§ Acceleration

§ Deceleration

§ Jerk

5: MC_Stop Axis is brought to a
standstill; next command
can be executed after
standstill

Velocity § Deceleration

§ Jerk

6: MC_Home Axis is referenced Depending on the
selected referencing
type

§ Velocity, override

§ Acceleration

§ Deceleration

§ Jerk

§ Torque/force

8: MC_MoveSpeed Axis moves without end
with set velocity (without
position control)

Velocity § Velocity, override

§ Acceleration

§ Deceleration

§ Jerk

9: MC_TorqueControl Axis moves without end
with set torque/force

Torque/force Torque/force

11: MC_Halt Axis is stopped; next
command can be
executed before
standstill

Velocity § Deceleration

§ Jerk

Tab. 43: Comparison of AC3 with Siemens telegram 111 (Program mode) with the PLCopen-based commands
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Settings (MDI mode) Command Feature Control type Necessary motion
variables

M550, bit 8 = 1 + 
bit 15 = 1

1: MC_MoveAbsolute Axis moves to an
absolute set position
(referencing
necessary)

Position § Position

§ Velocity, override

§ Acceleration

§ Deceleration

§ Jerk

M550, bit 8 = 0 + 
bit 15 = 1

2: MC_MoveRelative Axis moves a relative
distance; set position
is relative to the actual
position at the start of
the command

Position § Position

§ Velocity, override

§ Acceleration

§ Deceleration

§ Jerk

M550, bit 14 = 1 + 
bit 15 = 1

4: MC_MoveVelocity Axis moves without
end with set velocity
(with position control)

Position § Velocity, override

§ Acceleration

§ Deceleration

§ Jerk

M550, bit 15 = 1 + 
bit 11 = 1 (Start
homing procedure)

6: MC_Home Axis is referenced Depending on the
selected referencing
type

§ Velocity, override

§ Acceleration

§ Deceleration

§ Jerk

§ Torque/force

Tab. 44: Comparison of AC3 with Siemens telegram 111 (MDI mode) with the PLCopen-based commands

For detailed information on the motion commands, refer to the associated manual (see Further information [} 148]).
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6.2.4 Application class 4 (central motion control)
Application class 4 (AC4) is intended for velocity-controlled axes. This application class defines a set velocity interface with a
process of velocity control on the drive and position control in the controller. The position control loop is closed via the bus.
For optimal interaction, the controller and drives are synchronized via PROFINET IRT. This enables robotics and machine
tool applications with coordinated motion sequences of multiple drives.

Application Class 4

Automation

Technology

Drive Drive Drive

Closed Loop Speed Ctrl. Closed Loop Speed Ctrl. Closed Loop Speed Ctrl.

Control Word + Speed
Setpoint + ...

Status Word + 
Actual Position ...

M M MEncoder Encoder Encoder

Interpolation
Position Control

Clock Synchronous
Operation

Clock

Fig. 33: PROFIdrive: Application class 4 (source: PROFIdrive profile)

To control application class 4, the standard telegrams 3 and 5 as well as Siemens telegrams 102 and 105 are defined for
PROFIdrive and implemented in the application.



STÖBER 6 | More on PROFIdrive?
11

/2
02

5 
| 

ID
 4

43
27

0.
04

89

6.2.4.1 Standard telegram 3 in AC4

The standard telegram 3 (set velocity 32 bit with 1 position encoder) can be used in application class 1 or 4.

Structure

The mapping of the process data is specified by the controller (M512, M513).

The following tables show the structure of the telegram.

PZD no. Data type Name Parameter

1 WORD Control word 1 (STW1) M515

2 + 3 INT32 Speed setpoint B (NSOLL_B) M521

4 WORD Control word 2 (STW2) M517

5 WORD Sensor 1 control word (G1_STW) M526

Tab. 45: Standard telegram 3: RxPZD

PZD no. Data type Name Parameter

1 WORD Status word 1 (ZSW1) M516

2 + 3 INT32 Speed actual value B (NIST_B) M523

4 WORD Status word 2 (ZSW2) M518

5 WORD Sensor 1 status word (G1_ZSW) M527

6 +7 INT32 Sensor 1 position actual value 1 (G1_XIST1) M528

8 + 9 INT32 Sensor 1 position actual value 2 (G1_XIST2) M529

Tab. 46: Standard telegram 3: TxPZD

Input and output signals

1

00 n
%%

n
230

M571

Unfreeze ramp function generator

Enable ramp function generator

I10

Limit

M571

230

Motion
core

M521
NSOLL_B

M515 STW1, Bit 5

M515 STW1, Bit 4

M515
STW1, Bit 6

M528 G1_XIST1

M529 G1_XIST2

M523
NIST_B

Fig. 34: Standard telegram 3 in AC4: Input and output signals
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Control and status information

The telegram is specified by the controller in parameter M513. The active telegram is output in parameter M512. If
standard telegram 3 is active, the information 3: Standard telegram 3 is displayed there.

The following telegram-specific bits are assigned in control word 1 M515:

Bit Designation Comment

4 Enable ramp generator Activate calculation of the motion profile:
0 = velocity specification = 0; 
1 = velocity specification by Speed setpoint (M521)

5 Unfreeze ramp generator Unfreeze motion profile calculation:
0 = velocity specification = last velocity specification before freeze; 
1 = velocity specification by Speed setpoint (M521)

6 Enable setpoint Deactivate set velocity:
0 = velocity specification = 0; 
1 = velocity specification by Speed setpoint (M521)

12 Open brake Release brakes (prerequisite: F06 = 2: Parameter):

§ F92[0] = 0: Internal (automatic): Release override
0 = brake control is automatic depending on device state and motion
core;
1 = brakes release

§ F92[0] = 1: External (plc): Brakes are controlled externally by a
controller
0 = brakes engage; 1 = brakes release

Tab. 47: Standard telegram 3: telegram-specific bit in control word 1

The following telegram-specific bits are assigned in status word 1 M516:

Bit Designation Comment

8 Error within tolerance range Actual velocity within the permitted tolerance around the set velocity
(source: M598):
0 = inactive; 1 = active

10 Target velocity reached Target velocity reached (source: M596):
0 = inactive; 1 = active

11 Torque/force limit not reached Torque/force limit not reached (source: E180)

12 Brake control status

13 No overtemperature of the motor No overtemperature of the motor (source: E82, event
41: Temp.MotorTMP):
0 = inactive; 1 = active

14 Positive actual velocity Positive actual velocity (source: I88 > 0):
0 = inactive; 1 = active

15 No overtemperature of the drive
controller

No overtemperature of the drive controller (source: E82, event
38: Temperature drive controller sensor):
0 = inactive; 1 = active

Tab. 48: Standard telegram 3: telegram-specific bit in status word 1

Information

Parameter M571 Velocity reference value provides the reference value for the set velocity and actual velocity and ensures
the function of the application.
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6.2.4.2 Standard telegram 5 in AC4

The standard telegram 5 (set velocity 32 bit with 1 position encoder and Dynamic Servo Control) requires application
class 4.

Structure

The mapping of the process data is specified by the controller (M512, M513).

The following tables show the structure of the telegram.

PZD no. Data type Name Parameter

1 WORD Control word 1 (STW1) M515

2 + 3 INT32 Speed setpoint B (NSOLL_B) M521

4 WORD Control word 2 (STW2) M517

5 WORD Sensor 1 control word (G1_STW) M526

6 +7 INT32 Position deviation (XERR) M559

8 + 9 INT32 Position controller proportional coefficient (KPC) M560

Tab. 49: Standard telegram 5: RxPZD

PZD no. Data type Name Parameter

1 WORD Status word 1 (ZSW1) M516

2 + 3 INT32 Speed actual value B (NIST_B) M523

4 WORD Status word 2 (ZSW2) M518

5 WORD Sensor 1 status word (G1_ZSW) M527

6 +7 INT32 Sensor 1 position actual value 1 (G1_XIST1) M528

8 + 9 INT32 Sensor 1 position actual value 2 (G1_XIST2) M529

Tab. 50: Standard telegram 5: TxPZD

Input and output signals
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Fig. 35: Standard telegram 5 in AC4: Input and output signals
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Control and status information

The telegram is specified by the controller in parameter M513. The active telegram is output in parameter M512. If
standard telegram 5 is active, the information 5: Standard telegram 5 is displayed there.

The following telegram-specific bits are assigned in control word 1 M515:

Bit Designation Comment

4 Enable ramp generator Activate calculation of the motion profile:
0 = velocity specification = 0; 
1 = velocity specification by Speed setpoint (M521)

5 Unfreeze ramp generator Unfreeze motion profile calculation:
0 = velocity specification = last velocity specification before freeze; 
1 = velocity specification by Speed setpoint (M521)

6 Enable setpoint Deactivate set velocity:
0 = velocity specification = 0; 
1 = velocity specification by Speed setpoint (M521)

12 Open brake Release brakes (prerequisite: F06 = 2: Parameter):

§ F92[0] = 0: Internal (automatic): Release override
0 = brake control is automatic depending on device state and motion
core;
1 = brakes release

§ F92[0] = 1: External (plc): Brakes are controlled externally by a
controller
0 = brakes engage; 1 = brakes release

Tab. 51: Standard telegram 5: telegram-specific bit in control word 1

The following telegram-specific bits are assigned in status word 1 M516:

Bit Designation Comment

8 Error within tolerance range Actual velocity within the permitted tolerance around the set velocity
(source: M598):
0 = inactive; 1 = active

10 Target velocity reached Target velocity reached (source: M596):
0 = inactive; 1 = active

11 Torque/force limit not reached Torque/force limit not reached (source: E180)

12 Brake control status

13 No overtemperature of the motor No overtemperature of the motor (source: E82, event
41: Temp.MotorTMP):
0 = inactive; 1 = active

14 Positive actual velocity Positive actual velocity (source: I88 > 0):
0 = inactive; 1 = active

15 No overtemperature of the drive
controller

No overtemperature of the drive controller (source: E82, event
38: Temperature drive controller sensor):
0 = inactive; 1 = active

Tab. 52: Standard telegram 5: telegram-specific bit in status word 1

Information

Parameter M571 Velocity reference value provides the reference value for the set velocity and actual velocity and ensures
the function of the application.
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6.2.4.3 Siemens telegram 102 in AC4

The Siemens telegram 102 (set velocity 32 bit with 1 position encoder and torque reduction) can be used in application
class 1 or 4.

Structure

The mapping of the process data is specified by the controller (M512, M513).

The following tables show the structure of the telegram.

PZD no. Data type Name Parameter

1 WORD Control word 1 (STW1) M515

2 + 3 INT32 Speed setpoint B (NSOLL_B) M521

4 WORD Control word 2 (STW2) M517

5 WORD Torque reduction (MOMRED) M558

6 WORD Sensor 1 control word (G1_STW) M526

Tab. 53: Siemens telegram 102: RxPZD

PZD no. Data type Name Parameter

1 WORD Status word 1 (ZSW1) M516

2 + 3 INT32 Speed actual value B (NIST_B) M523

4 WORD Status word 2 (ZSW2) M518

5 INT16 Notification word (MELDW) M557

6 WORD Sensor 1 status word (G1_ZSW) M527

7 + 8 INT32 Sensor 1 position actual value 1 (G1_XIST1) M528

9 + 10 INT32 Sensor 1 position actual value 2 (G1_XIST2) M529

Tab. 54: Siemens telegram 102: TxPZD

Input and output signals
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Fig. 36: Siemens telegram 102 in AC4: Input and output signals
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Control and status information

The telegram is specified by the controller in parameter M513. The active telegram is output in parameter M512. If Siemens
telegram 102 is active, there is the information 102: Telegram 102.

The following telegram-specific bits are assigned in control word 1 M515:

Bit Designation Comment

4 Enable ramp generator Activate calculation of the motion profile:
0 = velocity specification = 0; 
1 = velocity specification by Speed setpoint (M521)

5 Unfreeze ramp generator Unfreeze motion profile calculation:
0 = velocity specification = last velocity specification before
freeze; 
1 = velocity specification by Speed setpoint (M521)

6 Enable setpoint Deactivate set velocity:
0 = velocity specification = 0; 
1 = velocity specification by Speed setpoint (M521)

12 Open brake Release brakes (prerequisite: F06 = 2: Parameter):

§ F92[0] = 0: Internal (automatic): Release override
0 = brake control is automatic depending on device state
and motion core;
1 = brakes release

§ F92[0] = 1: External (plc): Brakes are controlled
externally by a controller
0 = brakes engage; 1 = brakes release

Tab. 55: Standard telegram 102: telegram-specific bit in control word 1

The following telegram-specific bits are assigned in status word 1 M516:

Bit Designation Comment

8 Error within tolerance range Actual velocity within the permitted tolerance around the
set velocity (source: M598):
0 = inactive; 1 = active

10 Target velocity reached Target velocity reached (source: M596):
0 = inactive; 1 = active

13 – 15 Reserved

Tab. 56: Standard telegram 102: telegram-specific bit in status word 1

The following telegram-specific bits are assigned in status word 2 M518:

Bit Designation Comment

5 CmdActRelBrk, release brake active

Tab. 57: Standard telegram 102: telegram-specific bit in status word 2

Information

Parameter M571 Velocity reference value provides the reference value for the set velocity and actual velocity and ensures
the function of the application.
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6.2.4.4 Siemens telegram 105 in AC4

Siemens telegram 105 (set velocity 32 bit with 1 position encoder, torque reduction and Dynamic Servo Control) requires
application class 4.

Structure

The mapping of the process data is specified by the controller (M512, M513).

The following tables show the structure of the telegram.

PZD no. Data type Name Parameter

1 WORD Control word 1 (STW1) M515

2 + 3 INT32 Speed setpoint B (NSOLL_B) M521

4 WORD Control word 2 (STW2) M517

5 WORD Torque reduction (MOMRED) M558

6 WORD Sensor 1 control word (G1_STW) M526

7 + 8 INT32 Position deviation (XERR) M559

9 + 10 INT32 Position controller proportional coefficient (KPC) M560

Tab. 58: Siemens telegram 105: RxPZD

PZD no. Data type Name Parameter

1 WORD Status word 1 (ZSW1) M516

2 + 3 INT32 Speed actual value B (NIST_B) M523

4 WORD Status word 2 (ZSW2) M518

5 INT16 Notification word (MELDW) M557

6 WORD Sensor 1 status word (G1_ZSW) M527

7 + 8 INT32 Sensor 1 position actual value 1 (G1_XIST1) M528

9 + 10 INT32 Sensor 1 position actual value 2 (G1_XIST2) M529

Tab. 59: Siemens telegram 105: TxPZD

Input and output signals
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Fig. 37: Siemens telegram 105 in AC4: Input and output signals
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Control and status information

The telegram is specified by the controller in parameter M513. The active telegram is output in parameter M512. If Siemens
telegram 105 is active, there is the information 105: Telegram 105.

The following telegram-specific bits are assigned in control word 1 M515:

Bit Designation Comment

4 Enable ramp generator Activate calculation of the motion profile:
0 = velocity specification = 0; 
1 = velocity specification by Speed setpoint (M521)

5 Unfreeze ramp generator Unfreeze motion profile calculation:
0 = velocity specification = last velocity specification before freeze; 
1 = velocity specification by Speed setpoint (M521)

6 Enable setpoint Deactivate set velocity:
0 = velocity specification = 0; 
1 = velocity specification by Speed setpoint (M521)

12 Open brake Release brakes (prerequisite: F06 = 2: Parameter):

§ F92[0] = 0: Internal (automatic): Release override
0 = brake control is automatic depending on device state and motion
core;
1 = brakes release

§ F92[0] = 1: External (plc): Brakes are controlled externally by a
controller
0 = brakes engage; 1 = brakes release

Tab. 60: Standard telegram 105: telegram-specific bit in control word 1

The following telegram-specific bits are assigned in status word 1 M516:

Bit Designation Comment

8 Error within tolerance range Actual velocity within the permitted tolerance around the set velocity
(source: M598):
0 = inactive; 1 = active

10 Target velocity reached Target velocity reached (source: M596):
0 = inactive; 1 = active

13 – 15 Reserved

Tab. 61: Standard telegram 105: telegram-specific bit in status word 1

The following telegram-specific bits are assigned in status word 2 M518:

Bit Designation Comment

5 CmdActRelBrk, release brake active

Tab. 62: Standard telegram 105: telegram-specific bit in status word 2

Information

Parameter M571 Velocity reference value provides the reference value for the set velocity and actual velocity and ensures
the function of the application.
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6.2.4.5 Dynamic Servo Control in AC4

The Dynamic Servo Control (DSC) concept for increasing dynamic control performance is part of the PROFIdrive profile. It
requires application class 4 and transmits the proportional coefficient of the position controller (KPC) and the position
deviation (XERR) in addition to the velocity feedforward control. This data is used to calculate the position control in the
drive. The interpolation of the set position is still done in the controller. The function improves the dynamic behavior of the
position control loop by minimizing the delays that normally occur with a set velocity interface.

6.2.5 Additional telegrams

Siemens additional telegram 750

Siemens additional telegram 750 can be projected in addition to a standard telegram or Siemens telegram. It provides
additional process data for torque feedforward control via additive torque and for different torque limits in the positive and
negative direction. The combination of standard telegram 3 or 5 with additional telegram 750, for example, offers a greater
range of functions compared to Siemens telegram 102 or 105.

The mapping of the process data is specified by the controller (M512, M513).

The following tables show the structure of the telegram.

PZD no. Data type Name Parameters

1 + 2 WORD Couple supplémentaire (M_ADD1) M562

3 + 4 WORD Maximum positive torque (M_LIMIT_POS) M563

5 + 6 WORD Maximum negative torque (M_LIMIT_NEG) M564

Tab. 63: Siemens additional telegram 750: RxPZD

PZD no. Data type Name Parameters

1 + 2 WORD Actual torque (M_ACT) M561

Tab. 64: Siemens additional telegram 750: TxPZD

Additional telegram 900

You can use additional telegram 900 for free assignment of further process data in all application classes.

Information

If you project additional telegram 900, define the additional process data that is to be transferred to the controller in
DriveControlSuite via the parameters A92 (RxPZD) and A96 (TxPZD). Elements [0] – [11] are used for axis A parameters and
elements [11] – [23] for axis B parameters. A data length of 12 bytes each is available for the receive and transmit process
data.
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6.3 Axis model
With the help of the axis model, you map the real mechanical environment of your drive project in DriveControlSuite by
parameterizing the axis type and the arrangement of existing encoders. The parameterization of the axis model is required
for the smooth operation and easy diagnosis of your drive train.

With I05 Type of axis, you select a rotational or a translational axis model and define whether the scaling of the axis is done
using either predefined or individually configured units of measure. With I00 Position range, you parameterize either an
endless (modulo) or a limited travel range. You parameterize the encoder arrangement by using B26 Motor encoder and
I02 Position encoder.

The 6th generation of STOBER drive controllers are specially developed for communication between the drive controller
and controller on the basis of the actual variables at the output (° or mm of real axis movement). The scaling of the axis
model is calculated by the drive controller's firmware independently of the encoder model, without any rounding errors or
drift.

If your axis model is not followed by any other gear ratios, you can operate the axis with output-side motion variables
where all nominal and actual values correspond to the real axis movement.

Information

The firmware processes values for the motion variables velocity, acceleration and jerk in the data type REAL32 (floating-
point number, 32 bits). Position values are processed in the INT32 data type (integer, 32 bits) to eliminate rounding errors
and enable precise movements.

Abbreviation Meaning

LinM Linear Motor

M Motor

MEnc Motor Encoder

PEnc Position Encoder

Rotational axis models

The following figures each show a rotational axis model consisting of a motor, a gearbox and a rotary table (endless
rotational) or a pointer (limited rotational). Rotational axis models support rotational motor encoders as well as rotational
position encoders.

n
n

1

2

MEnc Gear PEnc

M

Fig. 38: Endless-rotational motion: Rotary table

M

MEnc PEncGear

n
n

1

2

Fig. 39: Limited-rotational motion: Pointer
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Translational axis models

The following figures each show a translational axis model consisting of a motor, gearbox, feed and conveyor belt (endless
translational) or tool slide (limited translational). Translational axis models support rotational motor encoders as well as
rotational or translational position encoders.

MEnc
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n
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Gear PEnc Feed

M

PEnc

n
x

Fig. 40: Endless translational motion: Conveyor belt

M

MEnc Gear

n
n

1

2

PEnc Feed

PEnc

n
x

Fig. 41: Limited translational motion: Tool slide

Translational axis model: Linear motor

The following figure shows a limited translation axis model using the example of a linear motor. Linear motors only support
translational motor encoders and translational position encoders.

MEnc/PEnc

LinM

Fig. 42: Limited translational motion: Linear motor



6 | More on PROFIdrive? STÖBER

100

11
/2

02
5 

| 
ID

 4
43

27
0.

04

Encoder arrangement

You parameterize the encoder arrangement by using B26 Motor encoder and I02 Position encoder. The motor encoder for
velocity control is located on the motor shaft. The position encoder for position control is located on the gearbox output. If
you use only one of the two encoders, it will be used for both velocity and position control.

Encoder Parameterization Encoder arrangement

Motor encoder B26 ≠ 0: Inactive

I02 = 0: Motor encoder
MEnc

n
n

1

2

Gear unit PEnc

M

Position encoder B26 ≠ 0: Inactive

I02 = B26
MEnc

n
n

1

2

Gear unit PEnc

M

Motor encoder & position
encoder

B26 ≠ 0: Inactive

I02 ≠ B26
MEnc

n
n

1

2

Gear unit PEnc

M
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6.4 Limit switches
With limit switches, you can secure the travel range by selecting the respective end of the travel range and thus limiting the
permitted positions of the axis. Hardware limit switches and software limit switches are available to limit the travel range.
Hardware and software limit switches can be used individually or in combination with each other.

Hardware limit switches are physical sensors (hardware) that are triggered when a certain position is reached, while
software limit switches are purely software-implemented functions for position limiting that are only available when the
travel range is limited (I00 = 0: Limited).

Function

When a limit switch is overshot, event 53: Limit switch is triggered and the axis goes into a fault condition with or without a
quick stop, depending on the parameterization. As soon as a limit switch is triggered, the motion core interrupts the current
motion command and refuses further commands in the same direction of motion. The direction lock ensures that the axis
can only move away from the limit switch in the opposite direction and return to the permitted travel range. As soon as the
direction lock is deactivated, event 53: Limit switch can be triggered again.

Further information on event 53: Limit switch, possible causes and actions can be found in the drive controller manual (see
Further information [} 148]).

ATTENTION!

Material damage due to leaving the permitted travel range

When a limit switch is overshot, the axis at the end of the permitted travel range will go into a fault condition, either with
or without a quick stop depending on the parameterization of the device control, so it may come to a standstill past the
limit switch and outside the permitted travel range.

▪ Allow sufficient space past the limit switch for your application to bring the axis to a standstill.

Restriction of the direction of motion

With an endless travel range, a direction lock can also be triggered by a positioning command outside the revolution length
or by restricting the direction of motion using I04 (travel range: I00 = 1: Endless; revolution length: I01; permitted direction:
I04). A restriction of the direction of motion is also indicated in the operating state of the axis (operating state: E80).

Since restricting the direction of motion using I04 prevents the hardware limit switch from moving in the opposite direction
of motion, it is generally not advisable to combine the two functions.
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6.4.1 Hardware limit switches
Hardware limit switches can be used for both limited and endless travel ranges (travel range: I00). A digital input or a
fieldbus can serve as the source for the digital signal for evaluating the respective hardware limit switch (source: I101, I102).

The digital signals for evaluating the hardware limit switches are low-active (normally closed contact), i.e. the limit switch is
triggered when the digital signal is interrupted (signal: I441, I442 = 0: Inactive). Ensure that the hardware limit switches and,
if necessary, the controller are connected correctly to prevent false triggering of event 53: Limit switch.

Relevant parameters

§ I101 Source positive /limit switch

§ I102 Source negative /limit switch

§ I441 Signal /HW limit switch positive

§ I442 Signal /HW limit switch negative

§ I805 Actual value HW-Limit switch positive

§ I806 Actual value HW-Limit switch negative

§ I52 Delete limit switch memory

§ I196 Direction blocking

Normal operation

When a hardware limit switch is overshot, event 53: Limit switch is triggered with a fault reaction.

Causes

§ 1: Hardware-Limit-Switch positive (prerequisite: I441 = 0: Inactive)

§ 2: Hardware-Limit-Switch negative (prerequisite: I442 = 0: Inactive)

A hardware limit switch is triggered when the digital signal for evaluating the hardware limit switches is interrupted. The
motion core interrupts the current motion command and refuses further commands in the same direction of motion; a
direction lock becomes active (denial: I91 = 1: Active; cause: I90; direction lock: I196).

The direction lock is deactivated as soon as the limit switch memory is reset.

Jog mode

With hardware limit switches, the behavior of the axis is independent of the control type selected for jog mode (I26). When
a hardware limit switch is overshot, the axis behaves the same way in jog mode as in normal operation.

Referencing

During referencing, hardware limit switches can be evaluated like reference switches by using the corresponding
referencing type (referencing type: I30 = 2: Limit switch; referencing methods: A, C, E, G).

With other referencing types, a triggered hardware limit switch reverses the direction of motion if the limit switch matches
the direction of motion (e.g. positive limit switch and positive direction of motion). If a triggered hardware limit switch does
not match the direction of motion, fault 53: Limit switch is triggered (e.g. positive limit switch with negative direction of
motion).

Example

At the start of referencing, the axis is between the reference switch and positive limit switch. The referencing direction is
positive. The axis moves in the positive direction and first encounters the positive limit switch, not the reference switch.
The axis reverses and searches for the reference switch in the other direction.
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Limit switch memory

When a hardware limit switch is overshot, the position of the limit switch is saved internally and the triggered limit switch is
recorded as active in the limit switch memory as long as the axis is at or past the limit switch (limit switch memory: I805,
I806). Based on the stored position of the limit switch and the digital signals for evaluating the hardware limit switches, the
limit switch memory is automatically reset in normal operation as soon as the axis has returned to the permitted travel
range.

I442

I806

I805

I441

1

4

3

2

Permitted travel range

HW limit switch negative HW limit switch positive

Position of the axis

Fig. 43: Hardware limit switch: Limit switch memory

1 Negative HW limit switch triggered, limit switch memory set

2 Negative HW limit switch exited, limit switch memory reset

3 Positive HW limit switch triggered, limit switch memory set

4 Positive HW limit switch exited, limit switch memory reset

Example

A positive hardware limit switch ranges from position 100 to 120; when moving in the positive direction of motion, it is
triggered at position 100 (signal: I441 = 1: Active → 0: Inactive). On the return journey, the tolerance may cause the real
hardware limit switch to be left at position 101 (signal: I441 = 0: Inactive → 1: Active). However, in order for the effective
limit switch or limit switch memory to be reset, position 100 must be reached or undershot.

The position of the limit switch is not stored in non-volatile memory, i.e. if the axis is outside the limit switches after
switching on, it must first be moved back into the permitted travel range.

During commissioning or in case of defective hardware limit switch connections, problems can arise with the saved
positions. These can be deleted with parameter I52. However, deletion only takes place if the corresponding limit switch
signal is inactive. Stored positions can also be deleted by referencing, setting a reference can be deleted using I452 or by
restarting the drive controller.

Controller start-up

If a controller is used as the source for the digital signals for evaluating the hardware limit switches and this is still in device
start-up while the drive controller and fieldbus communication are already active, event 53: Limit switch is triggered (cause:
7: Both limit switches not connected) and the limit switch memory is set (I805, I806 = 1: Active).

If the power unit has not yet been enabled since the supply voltage was switched on, the limit switch memory is
automatically reset as soon as the controller correctly transmits the signals for evaluating the hardware limit switches.
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6.4.2 Software limit switches
Software limit switches are only available with a limited travel range (I00 = 0: Limited). To be able to check the actual
position of the axis using software limit switches, the axis must be referenced.

The position of the negative software limit switch must be a smaller value than the position of the positive software limit
switch. If the same value is defined for both software limit switches, the function is deactivated.

Relevant parameters

§ I50 Software stop positive: Highest permitted position

§ I51 Software stop negative: Lowest permissible position

§ I22 Target window

§ I80 Current position

§ I196 Direction blocking

Normal operation

When a software limit switch is overshot, event 53: Limit switch is triggered with a fault reaction.

Causes

§ 3: SW-limit switch positive (prerequisite: I80 > I50 + I22)

§ 4: SW-limit switch negative (prerequisite: I80 < I51 – I22)

A software limit switch is triggered if the actual position of the axis is outside the permitted travel range, taking the position
window into account. The motion core interrupts the current motion command and refuses further commands in the same
direction of motion; a direction lock becomes active (denial: I91 = 1: Active; cause: I90; direction lock: I196).

The direction lock is deactivated as soon as the actual position of the axis is back within the permitted travel range, taking
the position window into account.

Jog mode

With software limit switches, the behavior of the axis depends on the control type selected for jog mode (I26).

If I26 = 0: Velocity control, a quick stop is triggered instead of a fault reaction when a software limit switch is overshot in jog
mode, so that the axis comes to a standstill outside the permitted travel range depending on the quick stop deceleration
(deceleration: I17). The direction lock ensures that the axis can only move away from the limit switch in the opposite
direction and return to the permitted travel range.

When I26 = 1: Position control and the set position is outside the permitted travel range, the axis is braked with jog
deceleration and tip jerk so that the axis still comes to a standstill within the permitted travel range shortly before the
software limit switch (deceleration: I45; jerk: I18).

Referencing

Software limit switches are not evaluated during referencing (motion command I401 = 6: MC_Home).
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6.5 Referencing
To be able to work with a system with absolute positions, the relation of a measured axis position to an actual axis position
must be determined.

During initial commissioning or after changes to the axis model, the actual position of the axis is unknown. A defined initial
position is necessary. As a rule, this is either identified through a reference search or referencing setting. The associated
process is referred to as referencing.

Absolute movements can be performed only in a referenced state. For relative movements, referencing is only required if
the software limit switch function is used at the same time.

When replacing a drive controller, the reference can be transferred to the replacement drive controller via an SD card. The
information is also saved on the SD card if the action A00 Save values is executed for the referenced axis. For more
information on replacing a drive controller, refer to the manual for the respective drive controller.

6.5.1 Referencing in AC1 and AC4
In application classes 1 and 4, the controller is responsible for the position of the axes and is thus responsible for
referencing the axes.

Position-capable technology objects are controlled for referencing via the PLCopen block MC_HOME.

Referencing Positioning axis/
Synchronous axis with
incremental encoder

Positioning axis/
Synchronous axis with

absolute encoder

External incremental
encoder

External absolute
encoder

Active referencing
(Mode = 3 or 5)

X — — —

Passive referencing
(Mode = 2, 8 or 10)

— — — —

Setting the actual
position
(Mode = 0)

X X — —

Relative displacement
of the actual position
(Mode = 1)

X X — —

Absolute encoder
adjustment
(Mode = 6 or 7)

— X — —

Tab. 65: Referencing in AC1 and AC4

For more information about the control of the PLCopen blocks, see the documentation from Siemens or the online help in
the TIA Portal.
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6.5.2 Referencing in AC3
In application class 3, the drive controller is responsible for the position of the axes, and therefore for referencing the axes.

Various referencing methods are available for referencing

6.5.2.1 Referencing methods

The following table shows an overview of the possible referencing methods.

Abbreviation Meaning

S Switch

M/F Torque or force

Method Initial
movement

Zero pulse Feature

S  A Negative Yes Negative limit switch

B Negative Yes Negatively positioned reference switch

C Negative – Negative limit switch

D Negative – Negatively positioned reference switch

S E Positive Yes Positive limit switch

F Positive Yes Positively positioned reference switch

G Positive – Positive limit switch

H Positive – Positively positioned reference switch

S I Positive Yes Centrally positioned reference switch

J Positive – Centrally positioned reference switch

S K Negative Yes Centrally positioned reference switch

L Negative – Centrally positioned reference switch

M Negative Yes Zero pulse

N Positive Yes Zero pulse

O – – Setting the reference

M/F P Positive – Torque/force stop

Q Positive Yes Torque/force stop

M/F R Negative – Torque/force stop

S Negative Yes Torque/force stop

Tab. 66: Referencing methods



STÖBER 6 | More on PROFIdrive?
11

/2
02

5 
| 

ID
 4

43
27

0.
04

107

6.5.2.1.1 Referencing methods in detail

The following chapters show the individual referencing methods in detail.

The following abbreviations are used in the graphs on the referencing methods:

Abbreviation Meaning

ALT Alternative

LS Limit Switch

RS Reference Switch

ZP Zero Pulse

Information

For graphically representing axes, the left is the smallest and the right is the largest position value. This means a positive
movement goes to the right and a negative to the left.

The following parameters are used in the descriptions of the referencing methods:

Coordinate Name

I28 Homing torque/force limit

I29 Time homing torque/force limit

I30 Referencing type

I31 Referencing direction

I32 Referencing speed fast

I33 Referencing speed slow

I34 Reference position

I35 Referencing with zero pulse

I39 Referencing acceleration

I43 Move to reference position

I44 Referencing jerk

I53 Index search offset

I101 Source positive /limit switch

I102 Source negative /limit switch

I103 Source reference switch
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6.5.2.1.1.1 Referencing method A

Referencing method A determines a reference using a run to the negative limit switch and zero pulse.

LS+LS-

LS-

ZP

Preparation

1. Activate referencing method A by setting the following parameters to the specified values:
I30 to 2: Limit switch,
I31 to 1: Negative,
I35 to 1: Active.

2. I102: 
Enter the data source for the negative limit switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the negative limit switch and continues its run with velocity I33 until it reaches
the next zero pulse after leaving the limit switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2.1.1.2 Referencing method B

Referencing method B determines the reference using a run to the negatively positioned reference switch and zero pulse.

RS

ZP

ALT 2

ALT 1

RS

Preparation

1. Activate referencing method B by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 1: Negative,
I35 to 1: Active.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.

ü Alternative 1: Drive is positioned in front of the reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it reaches the
next zero pulse after leaving the reference switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the positive direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity I33
until it reaches the zero pulse.

4. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2.1.1.3 Referencing method C

Referencing method C determines the reference using a run to the negative limit switch.

LS-

LS+LS-

Preparation

1. Activate referencing method C by setting the following parameters to the specified values:
I30 to 2: Limit switch,
I31 to 1: Negative,
I35 to 0: Inactive.

2. I102: 
Enter the data source for the negative limit switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the negative limit switch and continues its run with velocity I33 until it leaves
the limit switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the limit switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2.1.1.4 Referencing method D

Referencing method D determines the reference using a run to the negatively positioned reference switch.

RS

ALT 2

ALT 1

RS

Preparation

1. Activate referencing method D by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 1: Negative,
I35 to 0: Inactive.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.

ü Alternative 1: Drive is positioned in front of the reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it leaves the
reference switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 2: Drive stopped at reference switch

1. The drive starts with acceleration I39 and velocity I33 in the positive direction until it leaves the reference switch.

2. It changes its direction upon leaving the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity I33
until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon reaching the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2.1.1.5 Referencing method E

Referencing method E determines the reference using a run to the positive limit switch and zero pulse.

LS+

ZP

LS+LS-

Preparation

1. Activate referencing method E by setting the following parameters to the specified values:
I30 to 2: Limit switch,
I31 to 0: Positive,
I35 to 1: Active.

2. I101: 
Enter the data source for the positive limit switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the positive limit switch and continues its run with velocity I33 until it reaches
the next zero pulse after leaving the limit switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2.1.1.6 Referencing method F

Referencing method F determines the reference using a run to the positively positioned reference switch and zero pulse.

RS

ZP

ALT 2

ALT 1

RS

Preparation
1. Activate referencing method F by setting the following parameters to the specified values:

I30 to 1: Reference input,
I31 to 0: Positive,
I35 to 1: Active.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.

ü Alternative 1: Drive is positioned in front of the reference switch

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it reaches the
next zero pulse after leaving the reference switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity I33
until it reaches the zero pulse.

4. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2.1.1.7 Referencing method G

Referencing method G determines the reference using a run to the positive limit switch.

LS+

LS+LS-

Preparation

1. Activate referencing method G by setting the following parameters to the specified values:
I30 to 2: Limit switch,
I31 to 0: Positive,
I35 to 0: Inactive.

2. I101: 
Enter the data source for the positive limit switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the positive limit switch and continues its run with velocity I33 until it leaves the
limit switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the limit switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2.1.1.8 Referencing method H

Referencing method H determines the reference using a run to the positively positioned reference switch.

RS

RS

ALT 2

ALT 1

Preparation

1. Activate referencing method H by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 0: Positive,
I35 to 0: Inactive.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between two referencing variants.

ü Alternative 1: Drive is positioned in front of the reference switch

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it leaves the
reference switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 2: Drive stopped at reference switch

1. The drive starts with acceleration I39 and velocity I33 in the negative direction until it leaves the reference switch.

2. It changes its direction upon leaving the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity I33
until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon reaching the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2.1.1.9 Referencing method I

Referencing method I determines the reference using a run to the centered reference switch and zero pulse.

LS+LS- RS

RS

ZP

ALT 2

ALT 1

ALT 3

LS+

Preparation

1. Activate referencing method I by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 0: Positive,
I35 to 1: Active.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, a distinction is made between three referencing sequences.

ü Alternative 1: Drive is positioned between the negative limit and reference switches

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it reaches the
next zero pulse after leaving the reference switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity I33
until it reaches the zero pulse.

4. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 3: Drive is positioned between the reference and positive limit switches

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the positive limit switch until the reference switch is reached.

3. Upon reaching the reference switch, the drive changes its velocity to I33 until it leaves the reference switch again.

4. The current actual position is set to the value of the reference position I34 after leaving the reference switch and upon
reaching the next zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2.1.1.10 Referencing method J

Referencing method J determines the reference using a run to the centered reference switch.

LS+LS- RS

RS

ALT 2

ALT 1

ALT 3

LS+

Preparation

1. Activate referencing method J by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 0: Positive,
I35 to 0: Inactive.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between three referencing sequences.

ü Alternative 1: Drive is positioned between the negative limit and reference switches

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it leaves the
reference switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I32 until it leaves the
reference switch.

3. When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity I33
until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon reaching the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 3: Drive is positioned between the reference and positive limit switches

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. Upon reaching the positive limit switch, the drive changes its direction and continues its run until it reaches the
reference switch.

3. Upon reaching the reference switch, the drive changes its velocity to I33 until it leaves the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2.1.1.11 Referencing method K

Referencing method K determines the reference using a run to the centered reference switch and zero pulse.

ALT 2

ALT 1

ALT 3

RS

ZP

ALT 2

ALT 1

ALT 3

LS-

LS+LS- RS

Preparation

1. Activate referencing method K by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 1: Negative,
I35 to 1: Active.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing

If the PLCopen command MC_Home is active, a distinction is made between three referencing variants.

ü Alternative 1: Drive is positioned between the reference and positive limit switches

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it reaches the
next zero pulse after leaving the reference switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.



STÖBER 6 | More on PROFIdrive?
11

/2
02

5 
| 

ID
 4

43
27

0.
04

121

ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the positive direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction again and continues at velocity I33
until it reaches the zero pulse.

4. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 3: Drive is positioned between the negative limit and reference switches

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the negative limit switch and continues its run until the reference switch is
reached.

3. Upon reaching the reference switch, the drive changes its velocity to I33 and continues its run until it reaches the next
zero pulse after leaving the reference switch.

4. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2.1.1.12 Referencing method L

Referencing method L determines the reference using a run to the centered reference switch.

RS

ALT 2

ALT 1

ALT 3

LS-

LS+LS- RS

Preparation

1. Activate referencing method L by setting the following parameters to the specified values:
I30 to 1: Reference input,
I31 to 1: Negative,
I35 to 0: Inactive.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing

If the PLCopen command MC_Home is active, a distinction is made between three referencing variants.

ü Alternative 1: Drive is positioned between the reference and positive limit switches

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33 until it leaves the
reference switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts with acceleration I39 and velocity I33 in the positive direction until it leaves the reference switch.

2. It changes its direction upon leaving the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction and continues its run at velocity I33
until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon reaching the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 3: Drive is positioned between the negative limit and reference switches

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the negative limit switch and continues its run until the reference switch is
reached.

3. When the reference switch is reached, the drive changes its velocity to I33 and continues its run until it leaves the
reference switch again.

4. The current actual position is set to the value of the reference position I34 upon leaving the reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

6.5.2.1.1.13 Referencing method M

This method determines the reference using a run to the zero pulse.

ZP

Preparation

1. Activate referencing method M by setting the following parameters to the specified values:
I30 to 3: Zero pulse,
I31 to 1: Negative,

2. I32, I39, I44, I34:
Define the set values necessary for the referencing.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

3. The drive comes to a standstill with deceleration I39.

4. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2.1.1.14 Referencing method N

Referencing method N determines the reference using a run to the zero pulse.

ZP

Preparation

1. Activate referencing method N by setting the following parameters to the specified values:
I30 to 3: Zero pulse,
I31 to 0: Positive,

2. I32, I39, I44, I34: 
Define the set values necessary for the referencing.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

3. The drive comes to a standstill with deceleration I39.

4. If I43 is set to 1: Active, the drive is positioned at reference position I34.

6.5.2.1.1.15 Referencing method O

Referencing method O determines the reference by setting the reference to any position.

Preparation

1. I30: 
Activate referencing method O by setting this parameter to 5: Define home.

2. I34: 
Define the reference position.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

The current actual position is set to the value of the reference position I34.
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6.5.2.1.1.16 Referencing method P

Referencing method P determines the reference using a run with a torque/force stop.

Preparation

1. Activate referencing method P by setting the following parameters to the specified values:
I30 to 4: Torque/force stopper,
I31 to 0: Positive,
I35 to 0: Inactive.

2. I32, I39, I44, I34: 
Define the set values necessary for the referencing.

3. I28, I29: 
Define the torque/force limit. If the actual torque for the time stored in I29 is above the limit defined in I28 for an
ongoing period, the torque/force limit is reached.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. The current actual position is set to the value of the reference position I34 when the torque/force limit is reached and
the time stored in I29 has elapsed.

3. The set values are set to the value 0 with deceleration I39.

4. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2.1.1.17 Referencing method Q

Referencing method Q determines the reference using a run with a torque/force stop and zero pulse.

ZP

Preparation

1. Activate referencing method Q by setting the following parameters to the specified values:
I30 to 4: Torque/force stopper,
I31 to 0: Positive,
I35 to 1: Active.

2. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

3. I28, I29: 
Define the torque/force limit. If the actual torque for the time stored in I29 is above the limit defined in I28 for an
ongoing period, the torque/force limit is reached.

4. I53:
Define the start of the search for the zero pulse search.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the torque/force stop and when the time stored in I29 has passed, and
continues its run with velocity I33 until it reaches the next zero pulse.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The set values are set to the value 0 with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2.1.1.18 Referencing method R

Referencing method R determines the reference using a run with a torque/force stop.

Preparation

1. Activate referencing method R by setting the following parameters to the specified values:
I30 to 4: Torque/force stopper,
I31 to 1: Negative,
I35 to 0: Inactive.

2. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

3. I28, I29: 
Define the torque/force limit. If the actual torque for the time stored in I29 is above the limit defined in I28 for an
ongoing period, the torque/force limit is reached.

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. The current actual position is set to the value of the reference position I34 when the torque/force stop is reached and
the time stored in I29 has elapsed.

3. The set values are set to the value 0 with deceleration I39.

4. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2.1.1.19 Referencing method S

Referencing method S determines the reference using a run with torque/force stop and zero pulse.

ZP

Preparation

1. Activate referencing method S by setting the following parameters to the specified values:
I30 to 4: Torque/force stopper,
I31 to 1: Negative,
I35 to 1: Active.

2. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

3. I28, I29: 
Define the torque/force limit. If the actual torque for the time stored in I29 is above the limit defined in I28 for an
ongoing period, the torque/force limit is reached.

4. I53:
Define the start of the search for the zero pulse search

Information

In case of a selected value for the torque/force variable that is too big, the machine can be damaged. In case of a selected
value that is too small, an incorrect reference position may be applied.

Referencing

If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the torque/force stop and after the time stored in I29 has passed, and continues
its run with velocity I33 until it reaches the next zero pulse.

3. The current actual position is set to the value of reference position I34 upon reaching the zero pulse.

4. The set values are set to the value 0 with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2.2 Reference position

Depending on the referencing type I30, the actual position I80 is replaced by the reference position I34 during the
referencing event.

6.5.2.3 Reference retaining

STOBER offers a convenient drive-based referencing system. Depending on the encoder model used and the reference
management, different types of reference retaining (I46) are offered.

6.5.2.4 Reference loss

Axis

In certain cases, an axis loses its reference, and its state changes from I86 = 1: Active to I86 = 0: Inactive.

Normal operation (axis)

During normal operation, encoder faults or actions can lead to a loss of the reference. If the reference was deleted by an
encoder event, it can subsequently be restored.

Information

Before restoring the reference, check the actual position displayed (I80). If in doubt, do the referencing again. If relative
encoders are used or if the axis was still moving during the encoder fault, the actual position displayed may deviate from
the real actual position of the axis.

Cause Check and action

Event 76: Position encoder Encoder fault Actual position may still be correct, restoring
the reference is not possible:

§ Check the actual position (I80).

§ Reference the axis again

Event 37: Motor encoder Encoder fault When using the motor encoder as a position
encoder (I02 = 0: Motor encoder), 2 faults are
triggered (37: Motor encoder and 76: Position
encoder); in display parameter E82 and in the
fault memory it is possible that only one fault is
displayed.

Actual position may still be correct, restoring
the reference is not possible:

§ Check the actual position (I80).

§ Reference the axis again

Action I38 Deleted reference Action I38 deletes the reference but does not
change the actual position displayed.

Actual position may still be correct, restoring
the reference is not possible:

§ Check the actual position (I80).

§ Reference the axis again

Tab. 67: Loss of reference of the axis in normal operation
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Parameter changes (axis)

Changing individual parameters or transferring a new configuration with changed settings can lead to a loss of the
reference.

Cause Check and action

Changing parameters Changed axis model Actual position is undefined if one of the
following parameters was changed:

§ B26 Motor encoder

§ C15 Gear ratio n1

§ C16 Gear ratio n2

§ C17 Feed constant numerator

§ C18 Feed constant denominator

§ I00 Position range

§ I01 Circular length

§ I02 Position encoder

§ I03 Axis polarity

§ I05 Type of axis

§ I07 Distance factor numerator position

§ I08 Distance factor denominator position

It is not possible to restore the reference:

§ Reference the axis again

Changing parameters Changed encoder interface Actual position is undefined if a parameter of
the H group was changed.

It is not possible to restore the reference:

§ Reference the axis again

Tab. 68: Reference loss of the axis due to parameter changes

Restarting the drive controller (axis)

Depending on the encoder type and method for reference retaining (I46), the reference of a previously referenced axis is
restored or deleted after a restart.

By default (I46 = 0: Normal), the reference for a multi-turn absolute encoder is retained after a restart if the axis was
referenced with this encoder. In all other cases, the reference is deleted as soon as the drive controller is switched off.

The method for reference retaining can be adapted in I46. In addition to the preset, the following further options are
available:

§ Reference is retained if the measuring range covers the entire travel range

§ Reference is retained as long as the position change in the switched-off state is less than the reference retention
window (I48)

§ Reference is retained regardless of the presence of an encoder

§ Reference is retained regardless of the encoder type

§ Reference is deleted when the drive controller is switched off
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Special case of incorrect motor connection (axis)

If a motor is inadvertently connected to the incorrect axis or the incorrect drive controller, such as after a case of service,
the drive controller behaves as follows after it is switched on:

§ The axis changes to the non-referenced state (I86 = 0: Inactive)

§ The actual position displayed is undefined

However, the information from the original motor and the associated reference data are stored in the drive controller.
After switching off the drive controller, connecting the correct motor and restarting the drive controller, the reference is
restored and the actual position is displayed correctly (prerequisites: multi-turn absolute encoder, referenced axis and
preset for reference retaining I46 = 0: Normal).

Master encoder

Actual positions of the master encoder are used in the Drive Based Synchronous application for synchronous operation.

In all applications except the Drive Based Center Winder application, the actual position of the master encoder can be used
to pass on the position of another encoder attached to the machine to the control system. The drive controller transfers the
position from the encoder interface to the respective fieldbus.

Master encoders behave in a similar way to position encoders. In certain cases, a master encoder loses its reference, and its
state changes from G89 = 1: Active to G89 = 0: Inactive.

Normal operation (master encoder)

During normal operation, encoder faults can lead to a loss of the reference.

Cause Check and action

Event 77: Master encoder Encoder fault Actual position of the master encoder is
undefined, it is not possible to restore the
reference:

§ Reference the master encoder again

Tab. 69: Reference loss of the master encoder in normal operation

Parameter changes (master encoder)

Changing individual parameters or transferring a new configuration with changed settings can lead to a loss of the
reference.

Cause Check and action

Changing parameters Changed axis model Actual position of the master encoder is
undefined if one of the following parameters
was changed:

§ G30 Position range master

§ G40 Circular length master

§ G47 Distance factor numerator master

§ G48 Distance factor denominator master

§ G104 Source master encoder

It is not possible to restore the reference:

§ Reference the master encoder again

Changing parameters Changed encoder interface Actual position of the master encoder is
undefined if a parameter of the H group was
changed.

It is not possible to restore the reference:

§ Reference the master encoder again

Tab. 70: Reference loss of the master encoder due to parameter changes
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Restarting the drive controller (master encoder)

Depending on the encoder type and method for reference retaining (G35), the reference of a previously referenced master
encoder is restored or deleted after a restart.

By default (G35 = 0: Normal), the reference for a multi-turn absolute encoder is retained after a restart if this encoder was
used for referencing. In all other cases, the reference is deleted as soon as the drive controller is switched off.

The method for reference retaining can be adapted in G35. In addition to the preset, the following further options are
available:

§ Reference is retained if the measuring range covers the entire travel range

§ Reference is retained as long as the position change in the switched-off state is less than the reference retention
window (I48)

§ Reference is retained regardless of the presence of an encoder

§ Reference is retained regardless of the encoder type

§ Reference is deleted when the drive controller is switched off

6.6 Synchronization: Sign-of-Life
Sign-of-Life is a life counter that helps the application in the motion controller (block in the controller that controls the
movement) and the application in the drive controller monitor each other. As soon as the application in the drive controller
has synchronized to the clock of the controller, the drive controller starts sending drive controller Sign-of-Life signals 
(DO-LS). This consists of four bits in the status word ZSW2 and follows the specification of the Sign-of-Life of the controller
(C-LS). If the drive controller no longer responds correctly and on time due to a synchronization error, an alarm is triggered
in the controller. If the controller or technology object do not behave in a synchronized manner, the drive controller
triggers fault 52: Communication with cause 16: PROFINET Sign-of-Life synchronisation failed.

Information

The Sign-of-Life mechanism is only active when synchronized operation is active in application class 4 (AC4).
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6.7 Measuring input
Using the measuring input function, when the signal of a measuring input is changed, e.g. by a limit switch, the drive
controller can detect the current actual position of the axis, store it temporarily and transfer it to the controller via
PROFINET.

In TIA Portal, the measuring input function is implemented via the TO_MeasuringInput technology object. This always
requires an assignment to another technology object (TO_PositioningAxis or TO_SynchronousAxis), the position of which is
evaluated by the measuring input. During the configuration in TIA Portal, you must define the number of the measuring
input. If 1 is selected, the measuring input must be connected to terminal X101, pin 1 of the drive controller (DI1). If 2 is
selected, the measuring input must be connected to pin 2 of X101 (DI2).

Different measuring jobs for one-time or cyclic measurement can be transferred to the drive controller. It monitors its local
digital inputs DI1 or DI2, measures the actual position when a signal is received and transfers this to the controller via the
PROFIdrive telegram.

Sequence of the measuring input function

The following figure shows an example of the measuring input function sequence when using the MC_MeasuringInput
block.

  1
  0

  1
  0

50
  0

  1
  0

  1
  0

50
  0

t

t

t

t

t

t

MC_x

Execute

Busy

Done

MeasuredValue1

MeasuringInput

TO_x.Position

Fig. 44: Sequence of the measuring input function

The TO_MeasuringInput technology object is controlled using PLCopen blocks MC_MEASURINGINPUT and
MC_ABORTMEASURINGINPUT.

At the Execute input of PLCopen block MC_MEASURINGINPUT, the measuring job is started with signal 1 (top line in the
time diagram). This activates the measuring input function and the drive controller waits for a signal at the input of the
measuring input. The block was parameterized with the measurement method Mode = 0, i.e. the measurement takes place
with the next rising edge. If the measuring input causes a rising edge at the digital input of the drive controller, the
controller measures the actual position of the axis exactly at this point in time. After a few milliseconds, the position value
is available at the MeasuredValue1 output.
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6.8 PROFIdrive device control
The PROFIdrive device control is based on the internationally standardized device profile PROFIdrive for electric drives. This
profile describes the behavior of a drive controller based on a device state machine. Each device state represents a specific
behavior.

For state transitions, the device state machine must receive certain bit combinations in control word 1 (STW1) according to
PROFIdrive. The bit combination in status word 1 and status word 2 (ZSW1, ZSW2) provides information about the current
state of the drive controller.

The following chapters describe the device states and the possible state transitions associated with them. You will also
learn what measures may be necessary on your part and what options there are for parameterizing the transitions.

Information

If you work with technology objects in TIA Portal, these take over the control of the PROFIdrive device state machine.
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6.8.1 PROFIdrive device state machine
The device state machine describes the different device states of the drive controller along with the possible state changes.

S5: Switching off

Not ready to switch on

S1: Switching on inhibited
(Switch on disabled)

S2: Ready for switching on (Ready to
switch on)

S3: Switched on

S4: Operation
(Operation enabled)

S51: Ramp stop

S52: Quick stop

0

16

1

2 7

63

4 5

14

9

8

12

13
15

10

11

Fig. 45: PROFIdrive device state machine: Device states and state changes

Priority levels are marked by dots. The more dots a state change has, the higher its priority. Accordingly, a state change
without any dots has the lowest priority.

Information

For the priority levels of stop reactions, the order is Ramp stop, Quick stop and Coast stop, with a Ramp stop having the
lowest priority and a Coast stop having the highest priority. The effect and priority of the stop reactions is independent of
their origin. A stop reaction with higher priority replaces a stop reaction with lower priority. All stop reactions triggered by
errors (error with Ramp stop, error with Quick stop, error with Coast stop) lead to a change to the S1: Switching on
inhibited or S2: Ready for switching on state. Depending on the type of fault, the change can be direct or indirect via the
fault reaction. The STO safety function is mapped as Coast stop, while drive-based braking within the SS1 safety function is
mapped as Quick stop.

Information

If you use a gravity-loaded axis with a brake, always switch off the drive using a controlled stop. This prevents the load from
dropping until the brake is fully engaged. For a controlled stop, the Ramp stop or Quick stop function is used: state
transition 10, 11 or 15 according to the device state machine.
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6.8.2 States and transitions
All states and transitions provided by the device control according to PROFIdrive have specific features.

States

The bit combination in status word 1 and status word 2 (M516, M518) provides information about the state of the drive
controller.

The following table shows the states of the device control and the corresponding bit combination in status word 1 and
status word 2.

State of the drive controller Status word 1 (M516) Status word 2
(M518)

Bit 0
Ready to 
switch on

Bit 1
Ready to
operate

Bit 2
Operation
enabled

Bit 6
Switching on

inhibited

Bit 11
Pulses enabled

S1: Switching on inhibited
(Switch on disabled)

0 0 0 1 0

S2: Ready for switching on
(Ready to switch on)

1 0 0 0 0

S3: Switched on 1 1 0 0 0

S4: Operation (released) 1 1 1 0 1

S5: Switching Off 1 1 0 0 1

Tab. 71: State of the drive controller according to PROFIdrive

Transitions

One state either transitions automatically to another or the transition requires certain bit combinations in control word 1
(M515).

Information

Bits 0 – 9 and 11 – 15 of M515 are only effective if the status word reports Control requested (M516, bit 9 = 1) and control
by the PLC is activated (M515, bit 10 = 1).

Information

The brake control is not defined by the PROFIdrive profile. The brake is either controlled by the drive controller
(prerequisite: F00 = 1: Active and F108 = 0: Internal (automatic)) or externally by a controller (prerequisite: F00 = 1: Active
and F108 = 1: External (plc), source: M515, bit 12).
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6.8.2.1 Not ready to switch on

Features

§ Drive controller and safety module are initialized and tested

§ The power unit as well as drive and activation functions are locked

§ Brakes remain engaged

Transition to S1: Switching on inhibited (1)

The drive controller switches to the S1: Switching on inhibited state automatically after initialization and successfully
completing the self-test (typically approx. 30 s).

6.8.2.2 Key

The following terms are used in the descriptions of the states and transitions:

Term Meaning

Enable active Additional enable signal is active (A300 = 1: Active, source: A60)

Enable inactive Additional enable signal is inactive (A300 = 0: Inactive, source: A60)

Quick stop in case of Enable-off active Quick stop in case of Enable-off is active (A44 = 1: Active)

Quick stop in case of Enable-off inactive Quick stop in case of Enable-off is inactive (A44 = 0: Inactive)

Fault without quick stop fault reaction Coast stop (A29 = 0: Inactive)

Fault with quick stop fault reaction Quick stop (A29 = 1: Active; quick stop deceleration: I17)

Fault with stop fault reaction Ramp stop

Tab. 72: States, transitions and conditions: Terms

6.8.2.3 S1: Switching on inhibited (Switch on disabled)

Features

§ Initialization has been completed

§ Self-test was successfully completed

§ The power unit as well as drive and activation functions are locked

Possible causes of a switch-on lockout include:

1. Insufficient or no supply voltage/DC link feed-in

2. STO safety function is active

3. Coast stop is active (source: M515, bit 1 = 0)

4. Quick stop is active (source: M515, bit 2 = 0; cause only in states S1, S2, S3, S4 and S52)

5. Control by PLC is not active (source: M515, bit 10 = 0)

6. Drive has a fault

7. Release override is active (source: F06; cause only in states S1, S2 and S3)

8. Control panel or local operation is active (cause only in states S1, S2 and S3)

For the exact cause of a switch-on lockout, refer to parameter E49.
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Transition to S2: Ready for switching on (2)

M515, bit 0 (On) = 0

AND

M515, bit 1 (No coast stop) = 1

AND

M515, bit 2 (No quick stop) = 1

AND

No fault → M516, bit 3 (Fault present) = 0

AND

Enable active

AND

No cause for a switch-on lockout

6.8.2.4 S2: Ready for switching on (Ready to switch on)

Features

§ Power unit and drive function are disabled

§ Drive controller is ready to switch on

Transition to S3: Switched on (3)

M515, bit 0 (On) = 1

AND

M515, bit 1 (No coast stop) = 1

AND

M515, bit 2 (No quick stop) = 1

Transition to S1: Switching on inhibited (7), priority: 

M515, bit 1 (No coast stop) = 0

OR

M515, bit 2 (No quick stop) = 0

OR

Enable inactive

OR

Fault with or without fault reaction

OR

Cause for a switch-on lockout
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6.8.2.5 S3: Switched on

Features

§ Power unit is ready for operation

§ Drive function is locked; set values are not processed

Transition to S4: Operation (4)

M515, bit 0 (On) = 1

AND

M515, bit 1 (No coast stop) = 1

AND

M515, bit 2 (No quick stop) = 1

AND

M515, bit 3 (Enable operation) = 1

Transition to S2: Ready for switching on (6), priority: 

M515, bit 0 (On) = 0

Transition to S1: Switching on inhibited (8), priority:  

M515, bit 1 (No coast stop) = 0

OR

M515, bit 2 (No quick stop) = 0

OR

Enable inactive

OR

Fault with or without fault reaction

OR

Cause for a switch-on lockout
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6.8.2.6 S4: Operation (Operation enabled)

Information

If you use a gravity-loaded axis with a brake, always switch off the drive using a controlled stop. This prevents the load from
dropping until the brake is fully engaged. For a controlled stop, the Ramp stop or Quick stop function is used: state
transition 10, 11 or 15 according to the device state machine.

Features

§ Power unit is switched on

§ Drive function is enabled, set values are processed

Transition to S3: Switched on (5)

This transition brings the drive to an uncontrolled standstill. The power unit is disabled and axis movement is no longer
controlled by the drive controller.

M515, bit 3 (Enable operation) = 0

Transition to S1: Switching on inhibited (9), priority:   

This transition brings the drive to an uncontrolled standstill. The power unit is disabled and axis movement is no longer
controlled by the drive controller.

M515, bit 1 (No coast stop) = 0

OR

Enable inactive AND quick stop in case of Enable-off inactive

OR

Fault without quick stop fault reaction (Coast stop)

OR

Cause for a switch-on lockout

Transition to S51: Ramp stop (10), priority: 

M515, bit 0 (On) = 0

OR

Fault with stop fault reaction (Ramp stop)

Transition to S52: Quick stop (11), priority:  

M515, bit 2 (No quick stop) = 0

OR

Enable inactive AND quick stop in case of Enable-off active

OR

Fault with quick stop fault reaction (Quick stop)

OR

Request for drive-controlled SS1
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6.8.2.7 S5: Switching off

Various stop reactions are available. For the priority levels of stop reactions, the order is Ramp stop, Quick stop and Coast
stop, with a Ramp stop having the lowest priority and a Coast stop having the highest priority. Within the S5: Switching off
state, the prioritization of the different stop reactions is mapped using the S51: Ramp stop and S52: Quick stop states.

6.8.2.7.1 S51: Ramp stop

Features

§ Power unit is switched on; drive function is enabled

Transition to S4: Operation enabled (12)

M515, bit 0 (On) = 1

Transition to S2: Ready for switching on (13), priority: 

M515, bit 3 (Enable operation) = 0

OR

Standstill detected

Transition to S1: Switching on inhibited (14), priority:   

M515, bit 1 (No coast stop) = 0

OR

Enable inactive AND quick stop in case of Enable-off inactive

OR

Cause for a switch-on lockout

Transition to S52: Quick stop (15), priority:  

M515, bit 2 (No quick stop) = 0

OR

Enable inactive AND quick stop in case of Enable-off active

OR

Request for drive-controlled SS1
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6.8.2.7.2 S52: Quick stop

Features

§ Power unit is switched on; drive function is enabled

§ A quick stop is executed

Transition to S1: Switching on inhibited (14), priority:   

M515, bit 1 (No coast stop) = 0

OR

Enable inactive AND quick stop in case of Enable-off inactive

OR

Cause for a switch-on lockout

Transition to S1: Switching on inhibited (16)

M515, bit 3 (Enable operation) = 0

OR

Standstill detected

6.9 General control
In addition to the signals of the device control, which are implemented via the control word 1 (STW1, parameter M515) and
the status word 1 (ZSW1, parameter M516), a general control signal from STW1 is also used to influence the application. On
the application level, an MC_Stop is executed if bit 0 is set to the value 0. To operate the application, bit 0 must be set to
the value 1.

Bit Designation Comment

0 On Switch on voltage:
0 = inactive; 1 = active

Tab. 73: General control: Bit 0 in control word 1

6.10 General presets
The control signals are transmitted from the controller to the drive controller via fieldbus. For the start of a movement and
for the jog function, which is defined in the PROFIdrive profile, the following presets are therefore implemented in the
DriveControlSuite:

Parameter Default value

I100 Source execute 2: Parameter

I104 Source jog enable 2: Parameter

I105 Source positive jog 2: Parameter

I106 Source negativ jog 2: Parameter

Tab. 74: Presets: Source digital signals (application)
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6.11 Jog
The jog function is activated for all application classes and telegrams via control word 1 (M515). In control word 1, the
following bits are assigned for the jog function:

Bit Designation Comment

8 Jog 1 ON Positive jog (prerequisite: I104 = I105 = 2: Parameter):
0 = inactive; 1 = active

9 Jog 2 ON Negative jog (prerequisite: I104 = I106 = 2: Parameter):
0 = inactive; 1 = active

Tab. 75: Jog: Bit 8 + 9 in control word 1

The jog function is defined by the following parameters:

§ I12 Jog velocity

§ I13 Jog acceleration

§ I18 Jog jerk
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6.12 Required encoder values
In DriveControlSuite, H09 provides information about the encoder connection. If automatic readout from the drive
controller is not supported by the controller, you can find the necessary information in DriveControlSuite, Application
PROFIdrive wizard > Additional functions > Encoder data.

The following table contains the required values for STOBER encoders as an example:

Encoder
model

H09[0] Encoder
type

Measuring
system

Increments
per revolution

Number of
revolutions

Bit in
Gx_XIST1

Bit in
Gx_XIST2

ECN 1113 ED 2.1 13 Absolute Rotational 8192 1 0 0

ECI 1118 ED 2.1 18 Absolute Rotational 262 144 1 0 0

EQN 1125 ED 2.1 25
4096MT

(Cyclic)
absolute

Rotational 8192 4096 0 0

EQI 1130 ED 2.1 30
4096MT

(Cyclic)
absolute

Rotational 262 144 4096 0 0

ECI 1118 -G2 ECI 1118 Absolute Rotational 262 144 1 0 0

ECN 1123 ECN 1123 Absolute Rotational 8 388 608 1 0 0

EQI 1131
(EnDat 2.2)

EQI 1131 (Cyclic)
absolute

Rotational 524 288 4096 0 0

EQI 1131
(EnDat 3)

EQI 1131 (Cyclic)
absolute

Rotational 65536 4096 8 0

EBI 1135 EBI 1135 (Cyclic)
absolute

Rotational 65536 65536 3 0

EQN 1135 EQN 1135 (Cyclic)
absolute

Rotational 1 048 576 4096 3 0

ECN 1313 ED 2.1 13 Absolute Rotational 8192 1 0 0

EQN 1325 ED 2.1 25
4096MT

(Cyclic)
absolute

Rotational 8192 4096 0 0

EQN 1337 EQN 1337 (Cyclic)
absolute

Rotational 1 048 576 4096 5 0

ECN 113 ED 2.1 13 Absolute Rotational 8192 1 0 0

ECI 119 ED 2.1 19 Absolute Rotational 524 288 1 0 0

ECI 119-G2 ECI 119 Absolute Rotational 524 288 1 0 0

EBI 135 EBI 135 (Cyclic)
absolute

Rotational 65536 65536 3 0

EKM 36 EKM36-0KF0A
0S01

(Cyclic)
absolute

Rotational 262 144 4096 0 0

EDM 35 EDM35-2KF0A
024A

(Cyclic)
absolute

Rotational 1 048 576 4096 4 0

Resolver,
2-pole

Resolver x.xx Absolute Rotational 65536 1 0 0

HTL/ TTL SSI/INK/NONE Incremental Rotational Increments × 4 0 0 0

SSI SSI/INK/NONE Absolute Rotational Increments 1 0 0

Lean motor SSI/INK/NONE Incremental Rotational 65536 0 0 0

Tab. 76: Required encoder values



STÖBER 6 | More on PROFIdrive?
11

/2
02

5 
| 

ID
 4

43
27

0.
04

145

Information

In TIA Portal, under Encoder type, you can choose between Incremental, Absolute and Cyclic absolute. For multi-turn
absolute encoders (number of revolutions > 1), select the setting Cyclic absolute. The encoder overrun (zero crossing of the
encoder) is automatically taken into account by the technology object with this setting.

6.13 Cycle times
Possible cycle times can be found in the following table.

Type Cycle times Relevant parameters

PROFINET RT fieldbus, cyclical
communication

1 ms, 2 ms, 4 ms, 8 ms Adjustable in the TIA Portal

PROFINET IRT fieldbus, cyclical
communication

1 ms, 2 ms, 4 ms Adjustable in the TIA Portal

Tab. 77: Cycle times

6.14 Lag monitoring
In PROFIdrive type applications, you can monitor the lag of the axis with active position control in order to detect increasing
position deviations at an early stage. Monitoring the lag allows you to react quickly before material damage can occur, e.g.
in the event of stiffness or a mechanical blockage of the output.

To monitor the lag, the difference between the actual position of the axis and the set position x2set of the control is
determined and compared with the maximum permissible lag (actual position: I80; set position: I96; permissible lag: I21;
result: I187). If the permitted lag is exceeded, event 54: Following error is triggered with the corresponding protection level
(protection level: U22).
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7 Appendix

7.1 Supported communication objects

7.1.1 PROFIdrive Profile specific; parameter number (PNU): 900 – 999
The following table contains the supported profile-specific communication objects of the standardized PROFIdrive profile
and their mapping to the corresponding parameters of STOBER.

Parameter number (PNU) Transmit PZD Receive PZD Name Comment

922 — — Telegram selection M513

925 — — Number of controller Sign-of-Life
failures which may be tolerated

M538

930 — — Operating mode Constant value 1

944 — — Fault message counter M540

947 — — Fault number M543

950 — — Scaling of the fault buffer Constant value 8

952 — — Fault situation counter

964 — — Drive unit identification

965 — — Profile identification number

972 — — Drive reset A09

977 — — Transfer to non-volatile memory A00

979 — — Sensor format M537

980 — — Number list of defined parameter

Tab. 78: PROFIdrive Profile specific; PNU: 900 – 999

7.1.2 PROFIdrive Velocity reference value; parameter number (PNU):
60000

The following table contains the supported Velocity reference value communication object of the standardized PROFIdrive
profile as well as its mapping to the corresponding parameter of STOBER.

Parameter number (PNU) Transmit PZD Receive PZD Name Comment

60000 — — Velocity reference value M571

Tab. 79: PROFIdrive Velocity reference value; PNU: 60000
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7.1.3 PROFIdrive Communication system interfaces; parameter number
(PNU): 61000 – 61999

The following table contains the supported communication objects for the transmission of the standardized PROFIdrive
profile as well as their mapping to the corresponding parameters of STOBER.

Parameter number (PNU) Transmit PZD Receive PZD Name Comment

61000 — — Name of station A273

61001 — — IP of station A274

61002 — — MAC of station A279

61003 — — Default gateway of station A276

61004 — — Subnet mask of station A275

Tab. 80: PROFIdrive Communication system interfaces; PNU: 61000 – 61999
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7.2 Further information
The documentation listed below provides you with further relevant information on the 6th STOBER drive controller
generation. The current status of the documentation can be found in our download center at:
http://www.stoeber.de/en/downloads/.
Enter the ID of the documentation in the search field.

Title Documentation Contents ID

SC6 drive controller Manual System design, technical data, project configuration,
storage, installation, connection, commissioning,
operation, service, diagnostics

442790

Multi-axis drive system with SI6
and PS6

Manual System design, technical data, project configuration,
storage, installation, connection, commissioning,
operation, service, diagnostics

442728

PROFINET communication – 
SC6, SI6

Manual Electrical installation, data transfer, commissioning,
diagnostics, detailed information

443039

SU6 safety technology – 
STO and SS1 via PROFIsafe

Manual Technical data, installation, commissioning,
diagnostics, detailed information

443258

SR6 safety technology – 
STO via terminals

Manual Technical data, installation, commissioning,
diagnostics, detailed information

442741

Motion commands Manual Control and status information, denials and
limitations, motion

443349

Additional information and sources that form the basis of this documentation or are referenced by the documentation:

PROFIBUS Nutzerorganisation e. V. (PNO), 2015. Profile Drive Technology – PROFIdrive Profile. Technical specification for
PROFIBUS and PROFINET. Specification. Version 4.2, October 2015.

Information concerning the Siemens TIA Portal

The most important information about the Siemens TIA Portal and additional documents, links and training courses can be
found at 
http://www.industry.siemens.com/topics/global/en/tia-portal/pages/default.aspx.

GSD file

A GSD file for easily integrating the drive controllers of the 6th generation STOBER series into the respective system
environment can be found in the STOBER download center http://www.stoeber.de/en/downloads/, search term GSD.

7.3 Formula symbols

Symbol Unit Explanation

F N Force

M Nm Torque

n rpm Speed

n1 rpm Speed at gearbox input

n2 rpm Speed at the gearbox output

x mm Position

http://www.stoeber.de/en/downloads/
http://www.industry.siemens.com/topics/global/en/tia-portal/pages/default.aspx
http://www.stoeber.de/en/downloads/
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7.4 Abbreviations

Abbreviation Meaning

AC Application class

C-LS Controller life counter

DO-LS Drive controller life counter

DSC Dynamic Servo Control

FB Function Block

GSD General Station Description data

GSDML General Station Description Markup Language

IEC International Electrotechnical Commission

IP Internet Protocol

IRT Isochronous Real-Time

LinM Linear Motor

LS Limit Switch

LSB Least Significant Bit

M Motor

M/F Torque or force

MAC Media Access Control

MDI Manual Data Input

MEnc Motor Encoder

PEnc Position Encoder

PNU Parameter Number

PROFIBUS Process Field Bus

PROFINET Process Field Network

PZD Prozessdaten (process data)

RS Reference Switch

RxPZD Receive PZD (receive process data)

S Switch

STW Steuerwort (control word)

TIA Totally Integrated Automation

TO Technology Object

TxPZD Transmit PZD (transmit process data)

ZP Zero Pulse

ZSW Zustandswort (status word)
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8 Contact

8.1 Consultation, service and address
We would be happy to help you!

We offer a wealth of information and services to go with our products on our website:
http://www.stoeber.de/en/service

For additional or personalized information, contact our consultation and support service:
http://www.stoeber.de/en/support

If you need our system support:
Phone: +49 7231 582-3060
systemsupport@stoeber.de

If you need a replacement device:
Phone: +49 7231 582-1128
replace@stoeber.de

Call our 24-hour service hotline:
Phone: +49 7231 582-3000

Our address is:
STÖBER Antriebstechnik GmbH + Co. KG
Kieselbronner Strasse 12
75177 Pforzheim, Germany

8.2 Your opinion is important to us
We created this documentation to the best of our knowledge with the goal of helping you build and expand your expertise
productively and efficiently with our products.

Your suggestions, opinions, wishes and constructive criticism help us to ensure and further develop the quality of our
documentation.
If you want to contact us for a specific reason, we would be happy to receive an e-mail from you at:
documentation@stoeber.de

Thank you for your interest.
Your STOBER editorial team

http://www.stoeber.de/en/service
http://www.stoeber.de/en/support
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8.3 Close to customers around the world
We offer you committed, expert advise and support in over 40 countries worldwide:

STOBER AUSTRIA
www.stoeber.at
+43 7613 7600-0
sales@stoeber.at

STOBER CHINA 
www.stoeber.cn 
+86 512 5320 8850
sales@stoeber.cn

STOBER FRANCE 
www.stober.fr 
+33 478 98 91 80 
sales@stober.fr

STOBER Germany 
www.stoeber.de 
+49 7231 582-0
sales@stoeber.de

STOBER ITALY 
www.stober.it 
+39 02 93909570 
sales@stober.it

STOBER JAPAN 
www.stober.co.jp 
+81-3-5875-7583
sales@stober.co.jp

STOBER KOREA 
www.stober.kr 
+82 10 5681 6298 
sales@stober.kr

STOBER SWEDEN 
www.stober.com 
+46 702 394 675
neil.arstad@stoeber.de

STOBER SWITZERLAND 
www.stoeber.ch 
+41 56 496 96 50 
sales@stoeber.ch

STOBER TAIWAN 
www.stober.tw 
+886 4 2358 6089 
sales@stober.tw

STOBER TURKEY 
www.stober.com 
+90 216 510 2290 
sales-turkey@stober.com

STOBER UK 
www.stober.co.uk 
+44 1543 458 858 
sales@stober.co.uk

STOBER USA 
www.stober.com 
+1 606 759 5090 
sales@stober.com
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Glossary

Application class (AC)

Standardized drive functions according to the PROFIdrive device profile. In view of its wide range of possible
applications, six classes specified according to functionality have been defined for PROFIdrive. A drive can cover one or
more classes.

Broadcast domain

Logical grouping of network devices within a local network that reaches all nodes via broadcast.

Command

Operating mode in the Drive Based and Drive Based Synchronous applications. This enables configurable movements
to be shut down. The associated motion commands correspond to the PLCopen standard. An absolutely necessary,
higher-level controller coordinates the associated time-dependent sequences.

Dynamic Servo Control (DSC)

Concept of the PROFIdrive application to increase dynamic control performance. It requires application class 4 and
transmits the proportional coefficient KP of the position controller and the control difference e (position deviation) in
addition to the velocity feedforward control.

Function block

Functional software unit that includes a named copy of a data structure and associated operations defined by a
corresponding function block type.

GSD file

Includes the technical features of a PROFINET IO device (type, configuration data, parameters, diagnostic information,
etc.) in XML format in accordance with the GSDML specification. A GSD file serves as the configuration basis for project
configuration systems and is generally provided by the respective device manufacturer.

IO controller

Generally, a programmable logic controller that controls automation tasks and regulates data communication.

IO device

A decentralized field device that is assigned logically to a PROFINET IO controller that manages and controls it. An 
IO device consists of multiple modules and submodules.

IPv4 limited broadcast

Type of broadcast in a network with IPv4 (Internet Protocol version 4). The IP address 255.255.255.255 is entered as
the destination. The content of the broadcast is not forwarded by a router, which limits it to the local network.
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Jog

Step-by-step movement that can be used to move the drive incrementally and independently of the controller, such as
during commissioning, in emergency operation or during setup and repair work. Also: Name of a CiA 402 application
operating mode.

Limit switches

Element that triggers a signal when a certain position of a machine part needing to be moved is reached, as a result of
which further movement in this direction is prevented.

MAC address

Hardware address for unique identification of a device in an Ethernet network. The MAC address is assigned by the
manufacturer and consists of a 3-byte manufacturer ID and 3-byte device ID.

Measuring input

Function of the PROFIdrive application which the drive controller can use when the signal of a measurement input is
changed, e.g. by a limit switch, to detect the current actual position of the axis, store it temporarily and transfer it to
the controller via PROFINET.

Motion block

Operating mode in the Drive Based and Drive Based Synchronous applications. Summarizes the properties of
movements in the form of pre-defined motion blocks. Linking these enables the definition of complete motion
sequences, which makes it possible to execute sequences quickly – regardless of whether the motion sequences are
specified by a controller or executed through digital signals.

Process data (PZD)

Control and status information that is time-critical and transmitted in the PROFINET network cyclically using telegrams.
Depending on the view of the respective node, a distinction is made between receive PZD (RxPZD) and transmit PZD
(TxPZD).

PROFIdrive

Standardized drive interface for PROFIBUS and PROFINET open standard buses. It defines the device behavior and
procedure for accessing internal device data for electrical drives on PROFINET and PROFIBUS. The interface is specified
by PROFIBUS and PROFINET International (PI) user organizations, and is specified as the future-proof standard by
standard IEC 61800-7-303.

PROFINET

Open Ethernet standard of PROFIBUS Nutzerorganisation e. V. (PNO) for automation.

PROFINET IRT

Transmission method for high-precision as well as synchronized processes in a PROFINET IO system.

PROFINET RT

Transmission method for time-critical process data in a PROFINET IO system.
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PROFIsafe

Communication standard for safety standard IEC 61508 that includes both standard as well as fail-safe communication.
The standard enables reliable communication for PROFIBUS and PROFINET open standard buses based on standard
network components, and is defined as the international standard in standard IEC 61784-3-3.

Receive PZD (RxPZD)

Process data received by a node in the PROFINET network.

Referencing

When commissioning a system with a position measurement system, the relation of a measured axis to an actual axis
position must be determined. As a rule, a defined starting position is identified through either a reference search or a
reference setting. The associated process is referred to as referencing. Absolute movements can be performed only in
a referenced state.

Siemens telegram

Data with specified sequence and standardized contents that is exchanged cyclically between the controller and drive
controller during PROFIdrive communication. The standard telegram is structured according to the manufacturer-
specific specifications from Siemens.

Standard telegram

Data with specified sequence and standardized contents that is exchanged cyclically between the controller and drive
controller during PROFIdrive communication. The standard telegram is structured according to the PROFIdrive device
profile.

Technology object (TO)

Software object in a Siemens controller that represents a mechanical component. It encapsulates the technological
functionality and allows uniform configuration and parameterization.

Torque reduction

Function of the PROFIdrive application for limiting the torque during operation in application class 1 or 4.

Transmit PZD (TxPZD)

Process data sent by a node.
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